
VAIO C1 PictureBook Notebook

PCG-C1VN

www.sony.com

®

User Guide

Printed in USA 4-650-626-11© 2000 Sony Electronics Inc.

V
A

IO
 C

1 Pictu
reB

o
o

k N
o

teb
o

o
k U

se
r G

u
id

e

Download from Www.Somanuals.com. All Manuals Search And Download.



VAIO® C1 PictureBook™ 
Notebook User Guide
PCG-C1VN

Download from Www.Somanuals.com. All Manuals Search And Download.



VAIO® C1 PictureBook™ Notebook User Guide
Notice to Users

© 2000 Sony Electronics Inc. All rights 
reserved. This manual and the software 
described herein, in whole or in part, may not 
be reproduced, translated, or reduced to any 
machine-readable form without prior written 
approval.

SONY ELECTRONICS INC. PROVIDES NO 
WARRANTY WITH REGARD TO THIS 
MANUAL, THE SOFTWARE, OR OTHER 
INFORMATION CONTAINED HEREIN AND 
HEREBY EXPRESSLY DISCLAIMS ANY 
IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE WITH 
REGARD TO THIS MANUAL, THE 
SOFTWARE, OR SUCH OTHER 
INFORMATION. IN NO EVENT SHALL 
SONY ELECTRONICS INC. BE LIABLE 
FOR ANY INCIDENTAL, 
CONSEQUENTIAL, OR SPECIAL 
DAMAGES, WHETHER BASED ON TORT, 
CONTRACT, OR OTHERWISE, ARISING 
OUT OF OR IN CONNECTION WITH THIS 
MANUAL, THE SOFTWARE, OR OTHER 
INFORMATION CONTAINED HEREIN OR 
THE USE THEREOF.

Sony Electronics Inc. reserves the right to make 
any modification to this manual or the 
information contained herein at any time 
without notice. The software described herein is 
governed by the terms of a separate user license 
agreement.

This product contains software owned by Sony 
and licensed by third parties. Use of such 
software is subject to the terms and conditions 
of license agreements enclosed with this 
product. Some of the software may not be 
transported or used outside the United States. 
Software specifications are subject to change 
without notice and may not necessarily be 
identical to current retail versions.

Updates and additions to software may require 
an additional charge. Subscriptions to online 
service providers may require a fee and credit 
card information. Financial services may 
require prior arrangements with participating 
financial institutions.

The International ENERGY STAR Office 
Equipment Program is an international program 
that promotes energy saving through the use of 
computers and other office equipment. 
The program backs the development and 
dissemination of products with functions that 
effectively reduce energy consumption. It is an 
open system in which business proprietors can 
participate voluntarily. The targeted products 
are office equipment such as computers, 
displays, printers, facsimiles and copiers. Their 
standards and logos are uniform among 
participating nations. ENERGY STAR is a U.S. 
registered mark.

Sony, Handycam, Mavica, Media Bar, i.LINK, 
MovieShaker, PictureGear, VAIO and the VAIO 
logo are trademarks of Sony Corporation. 
Microsoft, Windows Me, Windows Media, 
Windows, Windows NT, and the Windows logo 
are registered trademarks of Microsoft 
Corporation. Crusoe is a trademark of 
Transmeta Corporation.

All other trademarks are trademarks of their 
respective owners

As an ENERGY STAR 
Partner, Sony Corporation 
has determined that this 
product meets the 

ENERGY STAR 
guidelines for energy 
efficiency.
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Owner’s Record

The model number and serial number are 
located on the bottom of your Sony Digital 
Studio. Refer to the model and serial number 
when you call your Sony Service Center.

Model Number: PCG-141A

Serial Number:________________________

Safety Information

WARNING

❑ To prevent fire or shock hazard, 
do not expose your notebook to 
rain or moisture.

❑ To avoid electrical shock, do not 
open the cabinet. Refer servicing 
to qualified personnel only.

❑ Never install modem or telephone 
wiring during a lightning storm.

❑ Never install telephone jacks in 
wet locations unless the jack is 
specifically designed for wet 
locations.

❑ Never touch uninsulated 
telephone wire or terminals 
unless the telephone line has been 
disconnected at the network 
interface.

❑ Use caution when installing or 
modifying telephone lines.

❑ Avoid using the modem during an 
electrical storm. 

❑ Do not use the modem or a 
telephone to report a gas leak in 
the vicinity of the leak.

❑ A socket outlet should be as close 
as possible to the unit and easily 
accessible.

AVERTISSEMENT

❑ Pour prévenir tout risque 
d’incendie ou d’électrocution, 
garder cet appareil à l’abri de la 
pluie et de l’humidité.

❑ Pour prévenir tout risque 
d’électrocution, ne pas ouvrir le 
châssis de cet appareil et ne 
confier son entretien qu’à une 
personne qualifiée.

❑ Ne jamais effectuer l’installation 
de fil modem ou téléphone durant 
un orage électrique.

❑ Ne jamais effectuer l’installation 
d’une prise téléphonique dans un 
endroit mouillé à moins que la 
prise soit conçue à cet effet.

❑ Ne jamais toucher un fil 
téléphonique à découvert ou un 
terminal à moins que la ligne 
téléphonique n’ait été débranché 
de l’interface réseau.

❑ Soyez très prudent lorsque vous 
installez ou modifiez les lignes 
téléphoniques.
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FCC Part 68

This equipment complies with Part 68 of the 
FCC rules. On the bottom of this equipment is a 
label that contains, among other information, 
the FCC equivalence number (REN) for this 
equipment. If requested, this information must 
be provided to the telephone company.

This modem uses the USOC RJ-11 telephone 
jack.

The REN is used to determine the quantity of 
devices which may be connected to the 
telephone line. Excessive RENs on the 
telephone line may result in the devices not 
ringing in response to an incoming call. In 
most, but not all areas, the sum of the RENs 
should not exceed five (5.0). To be certain of 
the number of devices that may be connected to 
the line, as determined by the total RENs, 
contact the telephone company to determine the 
maximum REN for the calling area.

If the terminal equipment causes harm to the 
telephone network, the telephone company will 
notify you in advance that temporary 
discontinuance of service may be required. But 
if advance notice is not practical, the telephone 
company will notify the customer as soon as 
possible. Also, you will be advised of your right 
to file a complaint with the FCC if you believe 
it is necessary.

The telephone company may make changes in 
its facilities, equipment, operations or 
procedures that could affect the operations of 
the equipment. If this happens, the telephone 
company will provide advance notice in order 
for you to make the necessary modifications in 
order to maintain uninterrupted service.

If trouble is experienced with this equipment, 
you can reach the Sony Customer Information 
Service Center at 1-888-4SONYPC; or write to 
the Sony Customer Information Service Center 
at 12451 Gateway Blvd., FL 33913, or find 
Sony Customer Service on the web at
http://www.sony.com/pcsupport.

Repair of this equipment should be made only 
by a Sony Service Center or Sony authorized 
agent. For the Sony Service Center nearest you, 
call 1-888-4SONYPC (1-888-476-6972).

This equipment cannot be used on public coin 
service provided by the telephone company. 
Connection to Party Line Service is subject to 
state and possible provincial tariffs. (Contact 
the state or provincial utility service 
commission, public service commission, or 
corporation commission for information.)

Telephone Consumer 
Protection Act of 1991
(United States)

The Telephone Consumer Protection Act of 
1991 makes it unlawful for any person to use a 
computer or other electronic device to send any 
message via a telephone facsimile machine 
unless such message clearly contains, in a 
margin at the top or bottom of each transmitted 
page or on the first page of the transmission, the 
date and time it is sent and an identification of 
the business, other entity, or individual sending 
the message, and the telephone number of the 
sending machine or such business, other entity, 
or individual.

In order to program this information into your 
facsimile machine, see your fax software 
documentation.
5
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INDUSTRY CANADA NOTICE

NOTICE: The Industry Canada label identifies 
certified equipment. This certification means 
that the equipment meets certain 
telecommunications network protective, 
operational and safety requirements as 
prescribed in the appropriate Terminal 
Equipment Technical Requirements 
document(s). The Department does not 
guarantee the equipment will operate to the 
user’s satisfaction.

Before installing this equipment, users should 
ensure that it is permissible to be connected to 
the facilities of the local telecommunications 
company. The equipment must also be installed 
using an acceptable method of connection.

The customer should be aware that compliance 
with the above conditions may not prevent 
degradation of service in some situations.

Repairs to certified equipment should be 
coordinated by a representative designated by 
the supplier. Equipment malfunctions or any 
repairs or alterations made by the user to this 
equipment may give the telecommunications 
company cause to request that the user 
disconnect the equipment.

Users should ensure for their own protection 
that the electrical ground connections of the 
power utility, telephone lines and internal 
metallic water pipe system, if present, are 
connected together. This precaution may be 
particularly important in rural areas.

Caution: Users should not attempt to make such 
connections themselves, but should contact the 
appropriate electric inspection authority, or 
electrician, as appropriate.

NOTICE: The Ringer Equivalence Number 
(REN) assigned to each terminal device 
provides an indication of the maximum number 
of terminals allowed to be connected to a 
telephone interface. The termination on an 
interface may consist of any combination of 

devices subject only to the requirement that the 
sum of the Ringer Equivalence Numbers of all 
the devices does not exceed 5. The Ringer 
Equivalence Number for this equipment is 0.1.

AVIS DE L’INDUSTRIE CANADA

AVIS: L’étiquette d’Industrie Canada identifie 
le matériel homologué.

Cette étiquette certifie que le matériel est 
conforme aux normes de protection, 
d’exploitation et de sécurité des réseaux de 
télécommunications, comme le prescrivent les 
documents concernant les exigences techniques 
relatives au matériel terminal. Le Ministère 
n’assure toutefois pas que le matériel 
fonctionnera à la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit 
s’assurer qu’il est permis de le raccorder aux 
installations de l’entreprise locale de 
télécommunication. Le matériel doit également 
être installé en suivant une méthode acceptée de 
raccordement. L’abonné ne doit pas oublier 
qu’il est possible que la conformité aux 
conditions énoncées ci-dessus n’empêche pas la 
dégradation du service dans certaines 
situations.

Les réparations de matériel homologué doivent 
être coordonnées par un représentant désigné 
par le fournisseur. L’entreprise de 
télécommunications peut demander à 
l’utilisateur de débrancher un appareil à la suite 
de réparations ou de modifications effectuées 
par l’utilisateur ou à cause de mauvais 
fonctionnement.

Pour sa propre protection, l’utilisateur doit 
s’assurer que tous les fils de mise à la terre de la 
source d’énergie électrique, des lignes 
téléphoniques et des canalisations d’
7
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Welcome
Congratulations on your purchase of the Sony VAIO® Notebook. Sony has 
combined leading-edge technology in audio, video, computing, and 
communications to provide you with state-of-the-art personal computing.

Features
Here are just some of the features your VAIO notebook computer has to 
offer (read the details in the Specifications chapter of this guide).

❑ Exceptional performance — Your computer includes a fast Crusoe™ 
processor.

❑ Portability — The rechargeable battery pack provides hours of use without 
AC power.

❑ Sony audio and video quality — A high-resolution LCD screen enables 
you to take advantage of today’s advanced multimedia applications, games, 
and entertainment software.

❑ Windows® Millennium Edition — Your system includes one of the latest 
operating systems from Microsoft.

❑ Communications — Access popular online services, send and receive 
e-mail, browse the Internet, and use the dialing and fax features.

✍ ��	���������
������	�
������
����������
����������	������������
�	����� �����
!"������
���#������$� ��%
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Unpacking Your Notebook
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Main Unit Power cord

AC adapter

AV Cable Rechargeable battery pack

Display adaptor Spare pointing device 
covers
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Unpacking Your Notebook
Manuals

❑ VAIO® User Guide — Contains information on setting up your notebook, 
supplementary updates and software information. This manual describes the 
features and specifications of your notebook, the applications included with 
your system, how to contract software vendors, and solve common 
problems.

❑ Microsoft® Windows® Millennium Edition Getting Started — Explains 
how to use the basic features of this latest Microsoft operating system.

Software CD

❑ Microsoft® Word 2000 — Allows you to reinstall Microsoft Word 2000 to 
the VAIO notebook you purchased.

Recovery CDs

❑ System Recovery CD(s) — Allows you to restore the software titles that 
shipped with your computer if they become corrupted or are erased. It can 
only be used to restore the hard disk of the VAIO notebook you purchased. 

❑ Application Recovery CD(s) — Allows you to reinstall individual 
applications or device drivers if they become corrupted or erased. 

Other

❑ Setting up your VAIO® Notebook (poster)

❑ Packet containing special product offers

✍ &������
�����	���'�	���(� ����������
����	�������
��	�
�����)*�(%�+���(*,�-�
�	'���	�
�����)�*(�(%�+��(�(��	'��.����!/��$�
���"��
�������������
���
,���'�	���(�#������$� 012�
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Ergonomic Considerations
You will be using your notebook computer as a portable device in a variety of 
environments. Whenever possible, you should apply the following ergonomic 
considerations to both stationary and portable environments.

❑ Position of your computer — Place the computer directly in front of you as 
you work. Keep your forearms horizontal, with your wrists in a neutral, 
comfortable position while using the keyboard, touchpad, or external mouse. 
Let your upper arms hang naturally at your sides. Take breaks during 
sessions with your computer. Excessive use of the computer may strain 
muscles or tendons.

❑ Furniture and posture — Sit in a chair with good back support and 
armrests. Adjust the level of the chair so your feet are flat on the floor. 
A footrest may make you more comfortable. Sit in a relaxed, upright posture 
and avoid slouching forward or leaning far backward.

Recommended position

Computer positioned
directly in front of you

Wrists relaxed
and flat

Arms at desk 
level
16
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Ergonomic Considerations
❑ Viewing angle of the computer’s display — Use the display’s tilting 
feature to find the best position. You can reduce eye strain and muscle 
fatigue by adjusting the tilt of the display to the proper position. You can 
adjust the brightness setting of the display also.

❑ Lighting — Choose a location where windows and lights do not create glare 
or reflection on the display. Use indirect lighting to avoid bright spots on the 
display. You can also purchase accessories for your display that help reduce 
glare. Proper lighting adds to your comfort and work effectiveness.

❑ Placement of an external display — When using an external display, set 
the display at a comfortable viewing distance. Make sure the display screen 
is at eye level or slightly lower when you are sitting in front of the monitor.

Notes on Setup

�����������������������

❑ Do not place your computer in a location subject to:

❑ Heat sources, such as radiators or air ducts

❑ Direct sunlight

❑ Excessive dust

❑ Moisture or rain

❑ Mechanical vibration or shock

❑ Strong magnets or speakers that are not magnetically shielded

❑ Ambient temperature of more than 95ºF (35ºC) or less than 40ºF (5ºC)

❑ High humidity

❑ Do not place electronic equipment near your computer. The computer’s 
electromagnetic field may cause a malfunction.

❑ Provide adequate air circulation to prevent internal heat build-up. Do not 
place your computer on porous surfaces such as rugs or blankets, or near 
materials such as curtains or draperies that may block its ventilation slots. 
Leave a space of at least 8 inches behind the back panel of the computer.

❑ The computer uses high-frequency radio signals and may cause k pan magn1. 
17
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❑ Do not use cut or damaged connection cables.

❑ If the telephone company makes a service call to your home or office and 
determines that your computer is responsible for a problem, the telephone 
company may bill you for the service call. Also, if you do not disconnect 
your computer when it is adversely affecting the telephone line, the 
telephone company has the right to disconnect your service until you correct 
the problem.

���
����������������

❑ Should any solid object or liquid fall into the computer, shut down your 
computer and then unplug it. You may want to have the computer checked by 
qualified personnel before operating it any further.

❑ Do not drop the computer or place heavy objects on top of the computer.

�
������������������

❑ Make sure to disconnect the power cord before cleaning the computer.

❑ Avoid rubbing the LCD screen as this can damage the screen. Use a soft, dry 
cloth to wipe the LCD screen.

❑ Clean the computer with a soft cloth lightly moistened with a mild detergent 
solution. Do not use any type of abrasive pad, scouring powder or solvent, 
such as alcohol or benzine.

���
��������� ��!���

❑ Do not leave the LCD facing the sun as it can damage the LCD. Be careful 
when using the computer near a window.

❑ Do not scratch the LCD or exert pressure on it. This could cause 
malfunction.

❑ Using the computer in low temperature conditions may produce a residual 
image on the screen. This is not a malfunction. When the computer returns to 
normal temperature, the screen returns to normal.

❑ A residual image may appear on the screen if the same image is displayed 
for a lengthy period of time. The residual image disappears in a while. You 
can use a screen saver to prevent residual images.
18
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Ergonomic Considerations
❑ The screen becomes warm during operation. This is normal and does not 
indicate a malfunction.

❑ The LCD is manufactured using high-precision technology. You may, 
however, see tiny black points and/or bright points (red, blue, or green) that 
continuously appear on the LCD. This is a normal result of the 
manufacturing process and does not indicate a malfunction.

"�#�����������������

❑ If the computer is brought directly from a cold location to a warm one, 
moisture may condense inside your computer. In this case, allow at least an 
hour before turning on your computer. If any problems occur, unplug your 
computer, and contact your Sony Service Center.
19
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Setting Up Your VAIO C1 
PictureBook™ Notebook
This section describes how to start using your notebook and the internal and 
external devices, such as the pointing device and optional floppy disk drive.

Locating the Controls and Connectors

Front

$ #"%&"��'�'�!�����

( #�!������

) �� ��!���

* +�,�����

- .����������!�

/ ��������

0 ��	�1�����1������������

2 #����,����!�����!����
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Locating the Controls and Connectors
Right

$ & �
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Bottom
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Connecting a Power Source
Connecting a Power Source
You can use either AC power or a rechargeable battery pack as a power source.

Using the AC Adapter

1 Plug the cable attached to the AC adapter into the DC In connector on the 
computer.

2 Plug one end of the power cord into the AC adapter.

3 Plug the other end of the power cord into an AC outlet.

������������5��5������

❑ Your computer operates on 100-240 VAC 50/60 Hz.

❑ Do not share the AC outlet with other power-consuming equipment, such as 
a copy machine or shredder.

❑ You can purchase a power strip with a surge protector. This device prevents 
damage to your computer caused by sudden power surges such as those that 
may occur during an electrical storm.

Connecting Computer to AC Outlet

✍ /������	���
�����������3
��
������������������
�	��&����������
����	���
������
������
�����	���
���������3�	����	�� ������$�
����������
�	��-������	��
��
�
���
����
	������
��
�������������������

Notebook computer

DC In
AC adapter 
(supplied)
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❑ Do not place heavy objects on the power cord.

❑ To disconnect the cord, pull it out by the plug. Never pull the cord itself.

❑ Unplug your computer from the wall outlet if you will not be using the 
computer for a long time.

❑ When the AC adapter is not in use, unplug it from the AC outlet.

❑ Use only the AC adapter supplied. Do not use any other AC adapter.

Using Battery Power

You can use a battery pack as a source of power. The PCGA-BP51A battery pack 
that comes with your computer is not fully charged at the time of purchase. 
Follow the steps below to insert and charge the battery pack.

%������������������,���!�

1 Make sure the Lock lever on the bottom of the computer is in the “unlock” 
position.

2 Align the grooves and tabs on the battery with the notches and tabs on the 
back of the computer. Slide the battery towards the computer until it clicks 
into place.

3 Slide the Lock lever into the lock position.

✍ 4��������������	������
����$�*�����
����)�*��%5�+��%6���

�	������������
����	�
����
���
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Connecting a Power Source
%��!����������������,���!�

1 Connect the AC adapter to the computer. 

2 Insert the battery pack.

The computer automatically charges the battery (the battery indicator light 
flashes in a double-blink pattern as the battery charges). When the battery is 85% 
full, the battery indicator light turns off. This process takes approximately one 
and one half hours. To charge the battery completely, continue charging for an 
additional hour. 

The  battery indicator indicates the status of the battery pack.

Inserting Battery Pack
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Grooves

Battery

LOCK UNLOCK

LOCK UNLOCK
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Battery Indicator Light
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On The computer is using battery power.

Single-blink The battery is running out of power.

Double-blink The battery is charging.

Off The computer is using AC power.
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%�������������������,���!�

1 Turn off the computer.

2 Slide the release levers to the UNLOCK position and slide the battery away 
from the computer.

Additional Notes On Batteries

❑ Never leave the battery pack in temperatures above 140° F (60° C), such as 
under direct sunlight or in a car parked in the sun.

❑ Battery life is shorter in a cold environment. This is due to decreased battery 
efficiency at low temperatures.

❑ Charge the batteries at temperatures between 50° F and 80° F (10° C to 
30° C). Lower temperatures require a longer charging time.

❑ While the battery is in use or being discharged, the battery pack heats up. 
This is normal and is not cause for concern.

❑ Keep the battery pack away from all sources of heat.

❑ Keep the battery pack dry.

❑ Do not open or try to disassemble the battery pack.

❑ Do not expose the battery pack to any mechanical shock.

❑ If you are not using the computer for an extended period of time, remove the 
battery pack from the computer to prevent damage to the battery.

Unlocking Battery Pack
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Battery lock/unlock lever

Battery release lever
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❑ If, after fully charging the battery pack, the battery power is still low, the 
battery pack may be reaching the end of its life and should be replaced.

❑ You do not need to discharge the battery before recharging.

❑ If you have not used the battery pack for a considerable amount of time, 
recharge the battery.

%������������������
�����?!���!��,�������,���!��9.�<5?6.-*:

Insert the battery pack with the VAIO logo side facing down. See the manual that 
came with the battery pack for more information.

Conserving Battery Power
When using the notebook computer with a battery, the LCD display and the hard 
drive can be set to switch off automatically to conserve battery power (Power 
Management function). For details, refer to page 59.

Inserting High-Capacity Battery Pack
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Starting Your VAIO C1 PictureBook Computer
1 Lift the cover while holding the bottom of the computer firmly. Do not grasp 

the camera lens when opening the cover as this may damage the unit.

2 Press the power button until the green power indicator light turns on.

Opening Your C1 PictureBook Computer
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Turning on Your C1 PictureBook Computer
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3 If necessary, adjust the brightness controls for the LCD display. To decrease 
the brightness, press Fn+F5 and then the down or left arrow key. To increase 
the brightness, press Fn+F5 and then the up or right arrow key.

Shutting Down Your Computer

1 Click the Start button on the Windows® taskbar.

2 Click Shut Down to display the Shut Down Windows dialog box.

3 Select Shut down.

4 Click OK.

5 Wait for your computer to turn off automatically. The power indicator 
turns off.

6 Turn off any peripheral devices connected to your computer.

&	�,����������
��������������,����!��������

1 Close or end all operations.

❑ Close all applications.

❑ Remove the PC cards.

❑ Disconnect USB devices.

2 Shut down your computer by pressing Ctrl+Alt+Delete keys (at the same 
time). 
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Using the Keyboard
Using the Keyboard
Your keyboard is very similar to a typewriter’s, but your notebook keyboard has 
additional keys that perform specific computer-related tasks.

Keyboard

+�,  ��!������

Numeric keypad area Contains the keys found on a typical calculator. Use the 
numeric keypad area to type numbers or to perform 
mathematical calculations such as addition and subtraction. 
Numbers appear on the front beveled edge of the numeric 
keys. Note that you must press the Num Lock key to activate 
the numeric keypad. (When you do so, the Num Lock light 
will be on.)

Navigation keys Several keys are devoted to moving the cursor on the screen 
(the four arrow keys which also function as the Home, End, 
Page Up, and Page Down keys). 

Correction keys The Insert, Backspace, and Delete keys enable you to make 
corrections in your documents. 

Navigation keys

Correction keys

Shift key

Numeric keypad area
33
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Combinations and Functions with the Windows Key

Function keys The twelve function keys along the top of the keyboard are 
used to perform designated tasks. For example, in many 
applications, F1 is the Help key. The task associated with 
each function key may vary from one application to the next.

Escape key The Esc (Escape) key is used to cancel commands.

Print Screen key The Print Screen key takes an electronic snapshot of the 
screen and places it in the Windows Clipboard. You can then 
paste the screen shot into a document and print it.

Operator keys Several keys are always used with at least one other key: Ctrl, 
Alt, and Shift. When held down with another key, the Ctrl 
(Control) and Alt (Alternate) keys offer another way to give 
commands. For example, in many applications, instead of 
choosing the Save command from a menu, you can hold 
down Ctrl and press S (referred to as Ctrl+S). The Shift key 
operates the same way as on a typewriter; it’s used to 
produce capital letters or special symbols such as @ and $.

Windows® key The key with the Windows® logo displays the Windows® 
Start menu; it’s the equivalent of clicking the Start button on 
the task bar. See “Combinations and Functions with the 
Windows Key” on page 34.

Fn key The Fn key is used in combination with other keys to issue 
commands. The Fn keys at the left and right sides both work 
the same. See “Combinations and Functions with the Fn 
Key” on page 36.

Applications key The Applications key displays a shortcut menu of 
context-sensitive choices; pressing this key is the equivalent 
of clicking the right mouse button.

��������� @�!���

 + F1 Displays Windows Help.

 + Tab Switches the selected button on the taskbar.

 + E Displays Windows Explorer.

 + F Displays the Windows Find: All Files window to find a file 
or folder. This is the equivalent of selecting Find and then 
Files or Folders from the Start menu.

+�,  ��!������
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Indicators

 + Ctrl + F Displays the Windows Find: Computer window where you 
can locate other computers. This is the equivalent of 
selecting Find and then Computer from the Start menu. 

 + M Minimizes all displayed windows (with Num Lock off).

Shift + + M Returns all minimized windows to their previous size.

 + R Displays the Run window. This is the equivalent of 
selecting Run from the Start menu.

Fn +  + Insert Displays the Properties window. This is the equivalent of 
double-clicking the System icon in the Control Panel.

&��!���� @�!���

Power Power on: lights green.
System Suspend mode: flashes umber.

Battery Indicates the status of the battery inserted in the
computer.

Hard disk Lights when data is read from or written to the hard drive. Do not 
enter System Suspend mode or turn off the computer when this 
indicator light is on.

��������� @�!���
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Combinations and Functions with the Fn Key

����� " "		

Memory Stick Data is read from or written to 
the Memory Stick. (Do not 
enter System Suspend mode or 
turn off the computer when this 
indicator light is on.)

The Memory Stick is not being 
accessed.

Num Lock Turns on when the number keys 
area in the numeric keypad are 
active.

Turns off when the alphanumeric 
character keys in the keypad area 
are active.

Caps Lock Turns on when the letters 
appear in uppercase as you 
type. The Shift key lowers the 
case of typed letters when Caps 
Lock is on. 

Turns off when letters appear in 
lower case as you type (unless you 
hold down the Shift key).

Scroll Lock Turns on when the screen 
scrolls differently. (Does not 
work with all applications.)

Turns off when information moves 
across the display normally.

����������1

@������

@�!����

Fn+  (ESC)
System Suspend

Puts the system into System Suspend mode, a power 
management state. To return the system to the active 
state, press any key or press the power switch on your 
computer.

Fn+  (F3)
Speaker switch

Toggles the built-in speaker off and on. 

Fn+  (F4)
Speaker volume

Adjusts the built-in speaker volume. 
To increase volume, press Fn+F4, then  or . 
To decrease volume, press Fn+F4, then  or .

Fn+  (F5) 
Brightness control

Adjusts the brightness of the LCD. 
To increase light intensity, press Fn+F5 and then  
or . 
To decrease light intensity, press Fn+F5 and then  
or .
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Fn+  (F7)
Switch to the 
external display

Toggles through the LCD, external display (connected 
to the  Monitor connector), and both LCD and 
external display.

Fn+  /  (F8) Switch 
to the TV

Toggles through LCD display and dual
LCD/TV.

Fn+  (F12)
System Hibernation

Provides for the lowest level of power consumption. 
When you execute this command, the state of the 
system and state of the peripheral devices are written 
to the hard disk and the system power is turned off. 
To return the system to the original state, use the power 
switch to turn on the power. 

Fn+D 
Video standby 

Turns off the LCD in order to save power. To return the 
LCD to an active state, press any key.

Fn+B
Bass Boost

Toggles the bass-boost function off and on. This 
feature is available only while using the headphone.

����������1

@������

@�!����

Only LCD LCD and external display

Only external display

LCD and TV

Only LCD
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Using the built-in MOTION EYE™ camera
Your computer includes a built-in MOTION EYE camera. You can use the 
camera to shoot still images and record video clips.

Capturing a still image

1 Press the CAPTURE button to start Smart Capture.

2 Select Still Viewer/Long Movie Player/Net Movie Player from the 
application list.
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Using the built-in MOTION EYE™ camera
3 Choose Still by clicking the on-screen Capture Mode button. To switch to 
Motion, click the on-screen Change Capture Mode button. (You can also use 
Jog Dial to control this function.)

4 The Finder window appears. Turn the MOTION EYE camera lens towards 
the subject you want to photograph.

5 Adjust the focusing ring.

Turning MOTION EYE

Adjusting the Focusing Ring
39
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6 Half-press the CAPTURE button on the computer. The image remains still 
for a few seconds. To display another image, release the CAPTURE button 
and press again.

7 Fully press the CAPTURE button. The still viewer window opens and the 
captured still image appears in the still viewer window.

8 For more detailed information about the capture software, refer to the online 
Help for Smart Capture.

�����������
	?�����

You can take a still image 10 seconds after clicking the CAPTURE button by 
using the self-timer.

1 Click Still Viewer/Movie Player from the switch applications list.

2 Select Still mode.

3 Click the Options button.

The Still Image Options dialog box appears.

4 Click Self-timer capture on the Capturing mode tab.

5 Click OK.
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Using the built-in MOTION EYE™ camera
%��!���������������!������

You can create panoramic images by connecting still images captured with the 
MOTION EYE camera.

1 Capture the still images. Using the panoramic-assist function of Smart 
Capture, capture still images to be used to create your panoramic image. 
For details, see Smart Capture online Help.

2 Start the PictureGear software. For details, see the PictureGear section in this 
manual.

%����������������A��
��,����������	�#"%&"��'�'�!�����

You can change the settings of image quality or mode of MOTION EYE camera.

1 Click the Start button, point to Settings, and then click Control Panel. 

2 Double-click the MOTION EYE camera icon. The Camera Control Utility 
appears.
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3 Click the Image tab and drag the slider to the left or the right. The level 
settings increase as the slider is moved to the right and decrease as it is 
moved to the left.

 

4 Click Mode tab and click the item you want to set.
 

5 Click OK.
 

@�������  ��!������

Brightness Adjust the brightness

Contrast Adjust the contrast of the light part and the dark part

Hue Adjust the hue of the color

Color Adjust the coloring

Sharpness Adjust the sharpness

@�������  ��!������

White balance Adjust the colors to be more natural.
Auto: Adjust automatically to natural colors.
Indoor: Suitable for indoor capturing.
Outdoor: Suitable for outdoor capturing.
Hold: Suspend the proximate settings of the white balance, 
so that settings do not change automatically.

 Shutter speed Set the shutter speed: 
Auto: Adjust the shutter speed automatically.

: This speed is suitable for capturing images under 
fluorescent light.
Hold: Suspend the proximate settings of the shutter speed, 
so that settings do not change automatically.
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Using the Pointing Device
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Using the Pointing Device
The pointing device on the keyboard allows you to point to, select, drag, and 
scroll objects on the screen. 

%�����
�!�����������������!��!����

You can take off the pointing device cover and replace it with the additional cover 
supplied with your computer.

Using the Pointing Device

5!���  ��!������

Point Press the pointing device in a direction to place the pointer on an item 
or object.

Click Press the left button once.

Double-click Press the left button twice.

Right-click Press the right button once. In many applications, this action displays 
a shortcut menu of context-sensitive choices.

Drag Press the pointing device in a direction to place the pointer on an item 
or object. While holding the left button, press the pointing device in a 
direction, and then release it at the desired point.

Scroll Press the pointing device while pressing the center button.
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P

Replacing the Pointing Device Cover
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Using PC Cards
Using PC Cards
Your computer includes a PC card slot. PC cards allow you to connect portable 
external devices, such as a CD-ROM drive, or to connect to a network.

To insert card 

1 Insert the PC card into the PC card slot with the front label facing up. Gently 
push the card into the slot until it is fixed into the connector; the release 
button comes out.
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Inserting PC Card

Insert in the direction of the arrow.
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2 Pull the release button, then push it down toward the slot.

%�����������.��!���

1 Double-click  in the task tray.

2 The “Unplug or Eject Hardware” dialog displays.

3 Select the hardware device you wish to remove by clicking it.

4 Click Stop.

5 Confirm the correct device is selected in “Stop a hardware device.”

6 The message, “PC Card can now be safely removed from the system” 
appears. Click OK.

7 Gently grasp the card and pull it out. 

8 Insert the PC card slot protector into the empty slot.

Release Button
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Release button
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Connecting with another VAIO® computer
You can connect your VAIO® notebook to another VAIO computer that has the 
preinstalled Windows Me operating system or the Sony Smart Connect 3.0 
software preinstalled. You may use an i.LINK® cable (optional) to connect the 
two systems and then use one computer to edit, copy, or delete files on the other 
computer. You can also print from a printer that is attached to either computer. 
Select the STD mode in Smart Connect 3.0 software to connect with your 
notebook.

Connecting with an i.LINK cable
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i.LINK cable (optional)
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Hard Drive Partition

In order to improve the performance of your computer’s DVgate™ Motion 
software, the hard disk drive on your computer has been formatted with two 
partitions, C (40%) and D (60%).* DVgate Motion saves files to the D partition. 
This prevents large video captures from consuming the available space on your 
C partition. To maintain optimum performance of DVgate Motion, you should 
defragment your D partition regularly. See the DVgate Motion online help for 
more information.

Connecting an i.LINK device
The VAIO C1 PictureBook Computer includes an i.LINK S400 (IEEE1394) 
connector, which you can use to connect to an i.LINK-enabled digital camcorder. 

%��!��!����������
�!��!�����

❑ Plug one end of an i.LINK cable into the  S400 connector on the left side 
of the computer and the other end into the DV In/Out connector on the 
digital camcorder.

* See“Specifications” on page 115.
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Connecting an i.LINK device

D

Connecting Digital Camcorder

✍ &���"�����$
��������	��	�����
�	��@����	��$
��������	��	����������
�����
������
�������	��
���

���"�����$
��������	��	� �������
�	����������!(����+��
#��	�!�>�?7#��	��
�����
�����

"���
����������
��
������3
�����	��$
��������	��	���	���	�����	��
������
��
����
�����������

&����>�?7�������
�	��������
����������3�	�
���:
�	������'��������
����:
�	������'���
	�<�	�����3�	��	���
����>�?7�������
�	 ����������
�����
�����'���3
�����	�
�����
�	�

&��������
�	�����������
�	������	
��
	�����	�	�
������
��688�-���@���3�'�	 �
���
��
����
	�����	�	�
����
�����3��
�
	�����	�	�
�����
����:
�	������'���

&����>�?7����
�	����'�����������'�	���������$����
������
3�	��������
��������
�����"���
����������
�
���
��
������3
�����	����
3�	����	���	�����	��
���
49

i g i t a l  c a m c o r d e r i . L I N K  c a b l e

t o  S 4 0 0 t o  D V  I n / O u t  

( o p t i o n a l )

Download from Www.Somanuals.com. All Manuals Search And Download.



VAIO® C1 PictureBook™ Notebook User Guide
DVgate™

 �����
�;�������������

If your system displays the message, “Failed to record to DV deck, please check 
deck’s power status, cable connection…,” while you are recording images to a 
digital video device using DVgate software, close all open applications, and 
restart your computer. Frequent recording of images to a digital video device 
while using DVgate may cause this situation to occur.

For more information on DVgate software, see the DVgate online help.

5�>������&���������
����

If the images on the LCD do not display smoothly, the resolution may not be set 
correctly. To check the resolution, click the Setup button in the DVgate 
Motion-Monitor window. Point to Settings, and then select Low Resolution. The 
settings you change in this menu affect the images in the monitor window only. 
Movie data imported to your hard drive and images recorded to DV devices will 
not be affected.
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J

VAIO Action Setup
VAIO Action Setup manages the settings for your computer's Jog Dial™ control, 
Memory Stick® media, and i.LINK® interface. An overview of some of the 
functions controlled by VAIO Action Setup is provided below. For more 
information on changing the settings using VAIO Action Setup, right-click the 
Jog Dial control icon  or , in the task tray and click Help Topics.

The Jog Dial™ Control
Your computer is equipped with a Jog Dial control on the right side of the unit. 
The Jog Dial control enables you to open an application, folder, or document 
from a predefined list by rotating and pressing the Jog Dial control. In addition, 
when you press the Jog Dial control, you can turn on your computer 
automatically and start the selected application or document.

The Jog Dial control window always appears in the display. It is either in the 
launcher mode or in the guide mode.

Using the Jog Dial Control
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Using the Jog Dial™ Control

This section explains how to use the Jog Dial control. For information on how to 
change the Jog Dial control’s settings, right-click the Jog Dial control icon in the 
task tray and click Help Topics.

Launcher Mode

The Jog Dial control window is in launcher mode until a software application is 
launched or the Jog Dial control window becomes active. When an arrow is 
displayed next to an item in the Jog Dial control window, you can display a 
submenu of that item by selecting it and pressing the Jog Dial control button.

��������!����#���

To use the Jog Dial control, click the Jog Dial control window or the Jog Dial 
control icon in the task tray. Alternatively, you can press the Jog Dial control 
while pressing the Ctrl key on the keyboard to switch to the launcher mode.

1 Turn the Jog Dial control to select the item you want, then press the Jog Dial 
control. The window switches to the guide mode, and shows the Jog Dial’s 
function.

2 Turn or press the Jog Dial control to use the desired function.

3 To select another item, switch to the launcher mode and repeat from step 1.

JOG Guide Dialog Box
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Guide Mode

The Jog Dial control window is in the guide mode when software is in use and 
the software window is active. Depending on the software you are using, you can 
select items from the displayed list using the Jog Dial control. Some Sony 
software applications have two modes in List View, Simple Menu, and Full 
Menu. You can switch the mode by pressing the Shift key while turning the Jog 
Dial control. 

�����<�����#���

The Jog Dial control window displays the Jog Dial’s function.

Using the Jog Dial Control with Sony Software

If Sony software that supports the Jog Dial control is active, you can use the Jog 
Dial’s functions that are allocated to that software. For more information on 
functions allocated to software, see the software applications online Help.

Using the Jog Dial Control with Other Software

If the software you are using does not support the Jog Dial control, you can still 
perform the following functions:

5!���  ��!������

Maximize Window*

* Some software does not support these functions.

Press the Jog Dial control button to maximize the size of 
the active window. Press again to return to normal 
window size.

Minimize Window* Press the Jog Dial control button to minimize the size of 
the active window. Press again to return to normal 
window size.

Finish Window* Press the Jog Dial control button to close the active 
application.

Scroll* Press the Jog Dial control button to begin scrolling 
within the active window.

Jog Dial Launcher Press the Jog Dial control button to return the Jog Dial 
control to Jog Launcher mode.

Menu Bar Press the Jog Dial control button, then use the Jog Dial 
control to scroll through the active window’s toolbar.
53

Download from Www.Somanuals.com. All Manuals Search And Download.



VAIO® C1 PictureBook™ Notebook User Guide
������� ��
���6��

When a window such as Screen Properties is active, the Dialog box is displayed 
in the Jog Dial window. You can select an item in the window by rotating the Jog 
Dial control. Pressing the Jog Dial control is the equivalent of pressing Enter.

Internal Timer

You can use the internal timer to start an application at a specific time. The timer 
can start applications even when the power is off.

JOG Guide dialog box
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Using Memory Stick® Media
This new compact, portable, and versatile recording medium has a data capacity 
exceeding that of a floppy disk. The media is specially designed for exchanging 
and sharing digital data with compatible products. Because it is removable, the 
media can be used for external data storage. 

Types of Memory Stick Media

Two types of Memory Stick media are available. The first type, MagicGate™ 
 Memory Stick media (hereafter referred as MG Memory Stick media), is 

provided with copyright protection. The second type, simply referred to as 
Memory Stick  media, does not have the same copyright protection as 
MagicGate.

You can use both media with your notebook.

For music, which requires copyright protection, you can only use MG Memory 
Stick media with your notebook. You can also use MagicGate-compatible 
devices to record and playback music when they are connected to your computer.

You can store mixed data on the Memory Stick media. For example, you can 
copy an image onto MG Memory Stick media that already contains music.

B�������#���!<���C

MagicGate is copyright protection that consists of authentication and encryption 
technology. Authentication technology ensures that protected content is only 
transferred between compliant devices and media. Protected content is recorded 
and transferred in an encrypted format to prevent unauthorized duplication or 
playback.

%��&�������#����,����!��#����

Insert the Memory Stick media into the media slot on the left side of the 
notebook until it clicks into place. When the Memory Stick media is properly in 
place, Sony’s VisualFlow™ software will automatically launch to display the 
contents of the Memory Stick.

✍ H���	��
��
�
���9�
9����
:��������������
���-)���	�� �
55

Download from Www.Somanuals.com. All Manuals Search And Download.



VAIO® C1 PictureBook™ Notebook User Guide

M

I n s e r t  i n  t h e  d i r e c t i o n

o

1 Insert with the arrow facing toward the Memory Stick media slot and the 
label facing down.

2 Carefully slide the Memory Stick in until it clicks in place.

%�����������!�������	�#����,����!�������

You can see the contents by clicking the Removable Disk (S:) icon. 
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1 Click Start, point to Settings and then Control Panel.

2 Click System. The System Properties window appears.

3 Select the Device Manager tab.
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Inserting Memory Stick
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Using Memory Stick® Media
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Make sure the access light is off. Push the media in toward the computer. When 
the media ejects, pull it out. When removing the Memory Stick media, be 
careful as it may eject completely from the slot.

VisualFlow

VisualFlow is a state-of-the-art Sony multimedia browser designed specifically 
for Memory Stick media. 

%������;����
@
��

1 From the Start menu, point to Programs > VisualFlow > VisualFlow.

2 Click on an icon in the View section on the main toolbar to select a display 
layout.

3 Click on an icon in the Sort section on the main toolbar to select a sorting 
method.

4 Resting your cursor on the left end of the main toolbar activates the current 
Memory Stick properties.

5 Resting your cursor on the right end of the main toolbar activates a 
secondary toolbar with more functions.

6 Click an image to show a normal view centered on the screen.

❑ Double-click an image to show an enlarged view.

7 Movie files start playback when the view is enlarged. Click again on movie 
files to restore the view to normal.
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Notes on using Memory Stick media:

❑ When the media's write-protect tab is set to LOCK, data cannot be recorded 
or erased.

❑ Before using Memory Stick media, you should back up important data.

❑ Wait a minimum of 10 seconds after the media finishes reading or writing 
data before removing it. If the media is removed prematurely, a blue screen 
with an error message appears, prompting you to continue or exit. Reinsert 
the media into the slot and press Enter to continue. This allows the media to 
finish reading or writing data.

❑ You can enjoy video clips that you have recorded with 
Memory Stick-compatible digital camcorders.

❑ The media slot can accommodate one media at a time.

❑ To copy images from a digital video camera via Memory Stick media, see 
“Connecting an i.LINK device” on page 48.

❑ Only MG™ Memory Stick media can be used with copyright protected data 
like music.

❑ Do not remove a media or turn off the power while the access light is on.

❑ Do not use the media in locations that are subject to static electricity or 
electrical noise.

❑ Do not touch the media connector with your finger or metallic objects.

❑ Do not attach labels other than the supplied label to a media.

❑ Do not bend, drop, or shock the media.

❑ Do not disassemble or modify the media.

❑ Do not allow the media to get wet.

❑ Do not use or store the media in a location that is subject to:

❑ Extremely high temperatures, such as in a car parked in the sun.

❑ Direct sunlight.

❑ High humidity or places with corrosive substances.

❑ To prolong the life of the media, use the supplied storage case. See the 
instructions that come with your media for more information on its use.
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Using Power Saving Modes
When you use a battery as the source of power for your computer, you can take 
advantage of power management settings to conserve battery life. In addition to 
the normal operating mode, which allows you to turn off specific devices, your 
computer has two distinct power saving modes: System Suspend and System 
Hibernation. When using battery power, you should be aware that the computer 
automatically enters System Hibernation mode when the remaining battery 
charge drops to approximately 10%, regardless of the power management setting 
you select.

Normal Mode

This is the normal state of your computer when it is in use. The green power 
indicator light is on in this mode. To save power, you can turn off a specific 
device such as the LCD or the hard disk.

System Suspend Mode

The computer saves the current state of the system in RAM and switches off 
power to the CPU. The green power indicator light flashes in this mode.

%���!��������,������������#���

Press Fn+Esc. You can also right-click on the battery icon in the task bar and 
select System Suspend mode.
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Press any key.
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System Hibernation Mode

The state of the system is saved on the hard drive and power is turned off. 
The power indicator light is off in this mode. 

%���!��������,�������������������

Press Fn+F12. You can also right-click on the battery icon in the task bar and 
select System Hibernation.

%����������������
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Turn on the computer by pressing the power button. The computer returns to its 
previous state.

❑ Time to return to normal mode:

System Suspend requires less time than System Hibernation.

❑ Power consumption:

System Suspend uses more power than System Hibernation.
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Connecting Peripheral Devices
You can add functionality to your computer by connecting any of these optional 
peripherals:

❑ Phone line (page 62)

❑ USB printer (page 64)

❑ USB mouse (page 65)

❑ External display (page 66)

❑ Microphone (page 75)

❑ USB floppy drive (page 69)

❑ CD/DVD-ROM drive (page 71)
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Connecting a Phone Line 
You need to connect a phone line (not supplied) to take advantage of online 
services and the Internet.

1 Open the phone line jack cover. The cover opens only to a 45-degree angle.

2 Plug one end of the phone cable into the jack on the inside of the phone line 
jack cover. Make sure you insert the phone cable from the rear of the 
computer and that the modular jack clicks into place.
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Opening Phone Line Jack Cover

Phone line 
jack cover
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Connecting a Phone Line

P h o n e  c a b l e  

P h o n e  l i n e  j a c k ( n o t  s u p p l i e d )
3 Plug the other end into the wall jack.

Plugging in Phone Cable
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P r i n t e r

Power cordUSB Printer cable 

(optional)

C o m p u t e r U S B  c o n n e c t o r
Connecting a USB Printer
You can connect a printer that is compatible with Windows Me™ to your 
computer. 

%��!��!����������

Plug the optional USB printer cable into the USB connector on your computer 
and the parallel port on your printer.

%��������������

To use a printer, first install the driver software that came with your printer.

Connecting a Printer
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Connecting a USB Mouse
Connecting a USB Mouse
You can connect an optional USB mouse PCGA-UMS1 series to your computer. 

%��!��!������6������

Plug the mouse cable into the USB connector. PCGA-UMS1 series driver has 
already been installed.
 

Connecting a USB Mouse
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USB Mouse
to 
USB Connector
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D

C o m p u t e r  d i s p l a y
Connecting an External Display
You can connect an external display to your VAIO C1 PictureBook Computer. 
For example, you can use the computer with either of the following:

❑ Computer display (monitor) (page 66)

❑ Projector (page 67)

❑ TV (page 68)

%��!��!����!������������
�,�

❑ Connect the supplied display adapter to the mini VGA/TV Out  
connector, and then plug the display cable into the adapter. 

❑ If necessary, plug one end of the power cord into the display, and the other 
end into an AC outlet.

Connecting a Display
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Connecting an External Display
%��!��!�������>�!����

You can use a projector as an external display, such as the Sony LCD Projector.

You can connect a projector using the supplied Display adapter.

1 Plug the display adapter into the computer's  Out  connector and the 
display’s RGB signal cable to the “VGA Out” connector of the Display 
adapter.

2 Plug the audio cable into the Headphone  connector.

Connecting a Projector

Power cord

RGB signal cable

to 
Monitor
67
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%��!��!����%;

Use the supplied AV cable to connect your TV monitor to your notebook.

1 Plug the supplied AV cable into the notebook’s AV Out connector.

2 Plug the other ends of the AV cable into the TV, as shown.
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Connecting a TV

T

Audio In
RL

Video In

TV Monitor

Power cord

AV cable (supplied)

Computer
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Using the Floppy Disk Drive (optional)
Using the Floppy Disk Drive (optional)
You can connect the optional floppy disk drive (FDD) to the  (USB) connector 
on your computer.

%��!��!������	
���,�����������

Plug the USB cable from the floppy disk drive into the  (USB) connector on 
the computer. The VAIO logo on the disk drive should be facing up.

%������������������
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Plugging in USB Cable
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1 Hold the diskette with the label side facing up.

2 Gently push the diskette into the drive until it clicks into place.

%�������������������

❑ When you finish using the diskette, wait until the LED indicator light turns 
off and then press the Eject button to remove the diskette.

%�������������	
���,��������������������!������������

1 Double-click the Remove Hardware icon  in the task tray.

2 The “Unplug or Eject Hardware” dialog displays.

3 Select the hardware device you wish to remove by clicking it.

4 Click stop.

5 Confirm the correct device is selected in the “Stop a Hardware device” 
dialog box.

Inserting diskette

Removing diskette

Diskette

Floppy disk drive

Eject button

LED indicator
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Connecting an Optical Drive (optional)
6 The message, “Floppy Disk Drive can now be safely removed from the 
system” appears. Click OK.

7 Slide the unlock lever on the bottom of the computer in the direction of the 
arrow, and then unplug the floppy disk drive from the computer.

%��!���,�����	
���,�����������

Fold the floppy disk cable into the compartment on the right side.

�����������
������������

❑ Do not open the shutter manually and touch the surface of the diskette.

❑ Keep diskettes away from magnets.

❑ Keep diskettes away from direct sunlight and other heat sources.

Connecting an Optical Drive (optional)
You can use the optional PCGA-CD51/A CD-ROM drive, or the 
PCGA-DVD51/A DVD drive with your notebook. If you use an optional drive 
when your computer is running on battery power, the battery life will be shorter. 
The drive draws power from the computer through a PC card.
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1 Open the start menu, select Settings, Control Panel, and then the 
System icon. The System Properties appear. Select Device Manager.

2 Click the Refresh button.

3 In the “Stop a Hardware device” dialog box, confirm that the device 
can be safely removed from the system. Click OK.
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%�����!������� � ����

1 Remove the PC card slot protector from the PC card slot. See “Using PC 
Cards” on page 45 for details.

2 Remove the PC card from the bottom side of the CD drive.

3 Insert the PC card into the PC card slot with the SONY logo facing up. See 
“Using PC Cards” on page 45 for details.
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Removing PC Card

Inserting PC Card
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Connecting an Optical Drive (optional)
%��&������� ��!

1 Press the Eject button. The disc tray slides out.

2 Place the disc in the tray with the label side facing up. Push the disc onto the 
hub until the disc clicks into place.

3 Close the tray by pushing it gently. The BUSY indicator on the drive flashes 
while your computer is reading data from the disc.

CD-ROM Drive

Inserting Disc

Eject button

Disc
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Notes on CD and DVD Media

%������������� ����

Remove the PC card from the computer. See “Using PC Cards” on page 45 for 
details.

���
���� ���� ; �#����

❑ Do not touch the surface of the disc.

❑ Do not drop or bend the disc.

�
������ ���� ; �#����

❑ Fingerprints and dust on the surface of a disc may cause read errors. Proper 
care of the disc is essential to maintain its reliability. Do not use solvents 
such as benzine, thinner, commercially available cleaners or anti-static spray, 
as they may cause damage to the disc.

❑ For normal cleaning, hold the disc by its edge and use a soft cloth to wipe the 
surface from the center out.

❑ If the disc is badly soiled, moisten a soft cloth with water, wring it out well, 
and use it to wipe the surface of the disc from the center out. Wipe off any 
remaining moisture with a dry soft cloth.

Flashing BUSY Indicator

Busy indicator
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Connecting External Speakers
Connecting External Speakers
You can enhance the sound quality of your computer by connecting external 
speakers.

%��!��!��������
���������

❑ Use the  symbol to locate the Headphone connector. Plug the speaker 
cable into this connector.

Connecting an External Microphone
You can enhance the quality of sound input by using an external microphone.

%��!��!����������
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Use the  symbol to locate the Microphone connector. Plug the microphone 
cable into this connector.
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Recording from a Microphone or Audio 
Equipment
You can record messages, memos, or other recordings in analog by connecting a 
microphone or other audio equipment to the Microphone connector of your 
notebook and then switching the connector functionality. The Microphone 
connector is for MIC IN (monaural).

Switching the connector functionality

To switch the Microphone connector functionality for use with a microphone or 
an audio device:

1 Double-click  on the task tray located in the lower right corner of the 
Desktop window. The Volume Control window appears. 

2 From the Options menu, click Properties. The Properties window appears.

3 In the Adjust Volume panel, select Recording, and then click OK. 
The Recording Control window appears.

4 Select either Microphone or Line.

5�>�������������
������������!�����������
������

When Microphone or Line are not displayed in the Recording Control window, 
from the Options menu, click Properties, click the item you want to display in 
Control, and then click OK.
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Recording from a Microphone or Audio Equipment
%���!����������������	�������!�������

1 Double-click  on the task tray located in the lower right corner of the 
Desktop window. If Microphone is not displayed, from the Options menu 
click Properties, select Microphone from the Control panel, and then 
click OK.

2 From the Microphone panel, click Advanced. The Advanced Controls for 
Microphones dialog box displays.

3 Click Mic 20dB in Other Controls, and then click Close.

5�>��������
���

You can adjust the sound device volume for playing or recording. 

To adjust the volume when playing, double-click  in the task tray located in 
the bottom right corner of the Desktop window. The Volume Control window 
displays.

To adjust the sound of other devices, from the Option menu, click Properties. In 
the Volume Adjust window, select Playback, and click the check box of the item 
you want to display in Control. Click OK.

���������!� @�!���

;�
���������
 Adjust the sound level from the speakers or 
headphones.

B5;' Adjust the wavfile sound or the effected sound of 
Windows.

.��6��� Adjust the beep sound when inserting or removing the 
PC card, etc.

%�
����� Adjust the modem or telephone line volume.

#�!������$ Adjust the internal or external microphone volume.

��� Adjust the audio equipment volume.

� �5���� Adjust the volume of the CD in the CD-ROM drive 
(PCGA-CD51/A is optional).

#& &( Adjust the MIDI sound.

) �B��� Widen the sound effect. (Effective for games, etc.)
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%�������������!��������!��

1 From the Start menu, select Settings, and click Control Panel. In the Control 
panel, double-click YAMAHA DS-XG.

2 Select the Echo tab.

3 Click Effective, you can also customize the setting by choosing options such 
as Time.

4 Click OK.

%���		�!������#& &������

1 From the Start menu, select Settings, and then select Control Panel. 

2 Click the YAMAHA DS-XG Audio Config icon. (If you do not see the icon 
that you are looking for, click “Display all the options of the Control Panel.”)

3 Select the Synthesizer tab.

4 Select the desired effect, and then click OK.

To adjust the sound volume when recording, double-click  in the task tray 
located in the lower right corner of the Desktop window.

1 From the Options menu, select Properties. 

2 In the Volume Adjust window, select Recording, and then click OK. The 
Recording Control window appears.

You can adjust the sound using the Smart Label software (included) or the sound 
recorder.
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%�
����, Adjust the modem or telephone line sound.

#�!������ Adjust the internal or external microphone sound.

��� Adjust the audio equipment sound volume.

� �5���� Adjust the digital sound volume of CD of the optional
CD-ROM drive (PCGA-CD51/A).

�������"�� Adjust the sound from Volume Control. The bass 
boost function is not enabled. 
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About the Software on Your Computer
About the Software on Your Computer
Your VAIO® notebook is ready to help you work, play, learn, and communicate 
as soon as you turn it on. This section gives you an overview of the activities you 
can perform with your software titles. For support information, see “For Answers 
to Your Software Questions” on “For Answers to Your Software Questions” on 
page 94.

Adobe Acrobat Reader®
Adobe Systems Inc.
Acrobat Reader software allows you to view, navigate, and print electronic documents in 
Adobe Portable Document Format (PDF), an open file format that is intended to preserve 
the fidelity of documents created on all major computer platforms.

ArcSoft® PhotoPrinter™ 2000 Pro
ArcSoft, Inc.
ArcSoft PhotoPrinter 2000 Pro is an easy-to-use, advanced printing program that lets you 
quickly lay out multiple images in multiple sizes on a single sheet of paper. PhotoPrinter 
Pro offers a wide selection of templates including landscape, portrait, free style, mixed 
sizes, custom templates and more. The application includes enhancement tools and special 
effects for improving photos while giving you the ability to add text to any image.

DVgate™

Sony Electronics Inc.
Connect a digital camcorder to the i.LINK® connector and capture your own video clips 
and still images. You can edit the clips from your video, add others, and combine clips into 
new movie segments. You can also save your images in a variety of popular file formats.

McAfee® VirusScan®
Network Associates, Inc.
Protect your computer from viruses. VirusScan can detect viruses from floppy disks, 
Internet downloads, e-mail attachments, intranets, shared files, CD-ROMs, and online 
services.
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Media Bar™

Sony Electronics Inc.
Media Bar software is your all-in-one solution for audio/video playback. Media Bar 
software handles all common computer multimedia formats and controls selected Sony 
devices. In addition to audio/video library cataloging and playlist management, Media Bar 
software includes digital video quality control and effects features. Media Bar software 
seamlessly integrates a variety of new media formats with an easy-to-use software 
interface.

Microsoft® Internet Explorer 
Microsoft Corporation
Internet Explorer delivers the web the way you want it. It is safe, easy to use, and you can 
personalize how you access the web. Outlook Express and other tools in Internet Explorer 
also help you have a great experience when you are on the web.

Microsoft® Word 2000
Microsoft Corporation
Microsoft Word 2000 makes it easy to create common web, e-mail, and print documents 
for use around the world. It embraces HTML as a first-class file format and extends this 
software’s ease-of-use to the web and e-mail. Word 2000 also extends that ease-of-use to 
international users, making it simple to create multilingual documents.

MovieShaker™

Sony Electronics Inc.
Sony’s original MovieShaker software creates personal movies that have transitions, 
background music, and text. Just import your video clips and “shake” with the click of a 
mouse. Your personal movies are easy to create and fun to share with family and friends.

Netscape Communicator®
Netscape Communications
Netscape Communicator is an all-in-one Internet tool that makes it easy to browse the 
web, send Internet e-mail, chat, read newsgroups and compose great web documents.

OpenMG™ Jukebox
Sony Electronics Inc.
OpenMG Jukebox software enables you to import digital audio files by downloading them 
from Electronic Music Distribution (EMD) services over digital networks, such as the 
Internet. You can record audio CDs onto your hard drive in a variety of formats.
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PictureGear™

Sony Electronics Inc.
This image management software displays images from your hard drive, a Sony Digital 
Still Camera, or a Sony Mavica® Camera. The images appear in a convenient light-table 
format, so that you can easily view the contents of an entire folder.

Quicken® 2000 Basic
Intuit, Inc.
Quicken is a fast, easy way to organize your finances. Quicken works just like your 
checkbook, so it is easy to learn and use. Quicken manages all your finances, bank 
accounts, credit cards, investments, and loans. You can even pay your bills online.

Smart Capture
Sony Electronics Inc.
Smart Capture is a fun new way to send multimedia messages via e-mail. Smart Capture 
manages the i.LINK connection between your computer and a Sony Digital Handycam® 
camcorder that supports the i.LINK interface. It allows you to capture compressed video 
or still images that you can save or share via e-mail. A smart solution to computer, digital 
audio/video, and network convergence.

VAIO Action Setup
Sony Electronics Inc.
VAIO Action Setup manages the settings for your computer’s shortcut keys and i.LINK 
interface.

VAIO Support Agent
Sony Electronics Inc.
VAIO Support Agent provides immediate, interactive on-line support.

VisualFlow™
Sony Electronics, Inc.
VisualFlow is a state-of-the-art Sony multimedia browser designed specifically for 
Memory Stick media. It displays any still picture, movie or sound files stored in a Memory 
Stick media in a visually pleasing, artistic manner. VisualFlow not only plays a selected 
movie or sound file, but also enables playback of files by other applications like 
PictureGear, Memory Stick Slideshow and Windows Explorer.
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OpenMG™ Jukebox Software Instructions
OpenMG Jukebox is a software application that utilizes Sony Corporation’s 
copyright protection technology. OpenMG Jukebox maintains the holder’s 
copyrights by preventing unauthorized distribution.

OpenMG Jukebox software enables you to import digital audio files by 
downloading audio files from EMD services over digital networks, such as the 
Internet. You can record audio CDs, which are encoded in ATRAC3 format, onto 
your computer’s hard drive. OpenMG Jukebox converts your existing MP3 and 
WAV format audio files into OpenMG format. (WAV format audio files are 
converted into ATRAC3 format, and MP3 format audio files are converted into 
ATRAC3 format or changed into OpenMG MP3 format.) 

Registering OpenMG Jukebox

The OpenMG registration icon  will appear in the Program Menu. Connect to 
the Internet, minimize the browser window, and then double-click the icon to 
register your software. When you register, you will be directed to the Electronic 
Music Distribution (EMD) service Web site, where you can download software 
that enables you to access Internet music.

'
�!����!�#���!� �����������9'# :������!��

EMD allows you to download music files via the Internet. To use 
OpenMG-enabled EMD services on the Internet, you need:

❑ Access to the Internet from your computer. Sign up with an Internet Service 
Provider and configure your computer for Internet access before using EMD 
services. 

❑ Free EMD programs such as EMD key installer. These programs can be 
downloaded from the Sony EMD Web page. 

❑ An EMD service provider. Consult the provider for details.
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OpenMG™ Jukebox Software Instructions
Starting OpenMG Jukebox

From the Windows Start menu, point to Programs. Point to OpenMG Jukebox, 
and then OpenMG Jukebox. OpenMG Jukebox displays.

OpenMG Jukebox Basic Controls
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OpenMG™ Jukebox Software Instructions
Recording a CD

1 Insert an audio CD into the optional CD/DVD-ROM drive.

2 Click Recorder. The OpenMG CD Recorder displays.

3 To select certain tracks from your CD, uncheck all unwanted tracks. 
You may also click Clear All, and then select the desired tracks.

4 Click � (record). Recording begins. When the recording is finished, 
the new Original album appears in the Album Title list of the 
OpenMG Jukebox window.
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Transferring Songs to the MG Memory Stick®

This section explains how to transfer CD tracks to the optional MG Memory 
Stick. See “To Insert a Memory Stick Media” on page 55 for details on using the 
MG Memory Stick media.

%���	�����������9���!�?���:

1 Click the Portable Player icon on the OpenMG Jukebox main window. 
The Portable Player window appears on the right side in the main window.

2 Select the desired album in the Album titles column, and click .

The song names in the selected album appear in the Song list of the 
Portable Player window.

3 Check-out begins. When check-out is complete,  changes to , 
and the shaded Song list area in the Portable Player window returns 
to normal state.
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�������������9���!�?�:

You can return songs recorded on the MG Memory Stick to the hard drive of 
your computer (check-in). You can return them only to the same computer from 
which the songs were checked out.

1 Start the OpenMG Jukebox software. 

2 Select the song you want to return in the Portable Player window, then click 
. To select more than one song, click the songs while holding down the 

Ctrl key. To check in all the songs, click the .

3 During check-in, the STOP button flashes. When check-in is finished, the 
song titles disappear from the Portable Player window. 

To exit OpenMG Jukebox

Close the OpenMG Jukebox window.

✍ &��������������*� ���������������
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Software Information
MovieShaker™
This application can be used to create fun and innovative movies without any 
knowledge of film editing. In a few simple steps, motion pictures can be 
combined with special effects, still images (pictures), and music files, and then 
saved in a format most computers can play.

Importing Images and Sound Clips

1 Click .

2 Find the file you want to add.

3 Select the file.

4 Click Open. The file is added to the Clip tray.

Main window

✍ �����	
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Clip tray

Working Panel

Product tray

Editing trays

Help

Trash
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Create a Movie Using Shaker

After adding clip(s) to the Clip tray, you can create a short movie using the 
Shaker feature. Shaker randomly selects clips from the Clip tray to create a 
30-second scene. 

1 Click the Shaker tab.

2 Select a mood by clicking a face in the Shaker tray.

3 Click . A thirty second scene is automatically generated and 
saved to the Product tray. 

4 To preview, switch the Work Panel to Product tray mode and press play.

Shaker Tray
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MovieShaker™
Editing Clips and Scenes

You can edit your movie by adding effects and text, adjusting the color and 
contrast, and modifying the length of clips.

Adding effects to a scene or a clip:

1 Double-click the clip or scene to move it to the Working Panel.

2 Select the Effects tab from the Editing tray.

3 Drag and drop the Effect you want to add from the Effects tray to the Effects 
palette on the Working Panel.

4 See Help for instructions on adjusting effect duration and replaying 
clips/scenes.

Saving a Movie

1 Verify that the clip(s) you want to save is on the Product tray. See Help for 
more details on saving movies.

2 Click Export.

3 Select the format in which you want the document to be saved.

Working Panel 
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Effect Palette

Trim Palette

Monitor

Effect Knobs
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4 Click Next.

5 Locate the folder to which you want the file saved.

6 Name the file.

7 Click Save.

PictureGear™
PictureGear is a digital image management application that allows you to see all 
the images stored in any directory on your computer. Thumbnail views provide 
quick reminders of your pictures. Brighten, contrast, enhance, resize, crop, and 
color-correct your pictures. Create panoramic views, animations, screen savers, 
wallpaper, still pictures from MPEG, and even html photo albums.

Managing Your Pictures

Use the collection feature to manage your pictures. 

1 Click the Folder tab and browse to locate your pictures.

2 Select the pictures you want to have in a collection.

3 From Collection menu, select Create New Collection.

4 Enter a name for the collection and then click OK.
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PictureGear™
Creating a Photo Album

1 Select the pictures you want to use to make an album.

2 From the Utilities menu, select Album Maker.

3 Choose the type of Album you want and click OK.

4 Now add more pictures, frames, text, and effects.

5 When you are finished, select Create Album in File menu or click the Create 
Album icon on the toolbar.

6 Designate the folder where you want to save the Album.

7 Enter the Target Album name, select Thumbnails and click OK.

8 The new album can be viewed using most internet browsers.

Using Panorama Maker

Panorama Maker stitches a group of still images into a 360 degree panoramic 
picture. The source images should be the same size and overlap 20%.

How to stitch a panoramic picture:

1 Gather the source images into the same folder or collection.

2 Select the images you want to use.

3 From the Utilities menu select Panorama Maker.

4 Select the correct lens and click OK. (If 35mm lens is selected, the prompt 
does not appear; to select a different lens, click the lens icon.)

5 Click the panoramic icon, near the bottom of the window.

6 Click Full Stitch.

Making Still Images and Panoramic from MPEG

1 Select the MPEG file.

2 From the Movie/Sound menu, select Scene break down.

3 Then select Movie Stitch, to create a panoramic picture.
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For Answers to Your Software Questions

5!�����®��������95������,������&!���������:

#!5	��®�;�����!�®�9��������5���!�����D�&!7:

����!����������!����8�9����!����������!����������7:

.����.�����C�(444�.���95�!��	�D�&!7:

Web site http://www.adobe.com/

phone 206-628-2746 (fee-based support)

fax 206-628-5737

e-mail techdocs@adobe.com

hours M-F, 6 AM-5 PM PT

Web site http://support.mcafee.com

phone 408-988-3832

e-mail cybr@nai.com

hours M-F 9AM-5PM Central Time

Web site http://www.netscape.com/

phone 888-4SONYPC (888-476-6972)*

* Support from 1-888-4SONYPC is free of charge for 90 days after the original date of purchase.

hours 7 days a week, 24 hours a day

Web site(s) http://www.arcsoft.com
http://www.photoisland.com

phone 510-440-9901

fax 510-440-1270

e-mail techsupport@arcsoft.com

hours M-F, 8:30 AM-5:30 PM PT
94

Download from Www.Somanuals.com. All Manuals Search And Download.



For Answers to Your Software Questions
E��!��®�(444�9&�����&!7:

B�����8�#�

�����'������"���������,����D�&������'��
����D�B����(444�
9#�!����	������������:

��,������!�������

For the Sony Service Center nearest you, call 1-888-4SONYPC 
(1-888-476-6972) or find Sony Customer Service on the Web at
http://www.sony.com/pcsupport.

Web site http://www.intuit.com/support

phone 900-555-4688

hours 7 days a week, 24 hours a day

Web site http://www.microsoft.com/support/

phone 888-4SONYPC (888-476-6972)*

* Support from 1-888-4SONYPC is free of charge for 90 days after the original date of purchase.

hours 7 days a week, 24 hours a day
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Using the System and 
Application Recovery CDs
The following sections describe how to use the System Recovery and Application 
Recovery utilities. You need to connect the optional CD-ROM drive 
(PCGA-CD51/A) or the DVD drive (PCGA-DVD51/A) drive, to use the System 
and Application Recovery CDs.

About Your Recovery CDs

Application Recovery CD(s)
Sony Electronics
This program allows you to reinstall individual applications and device drivers. Use it to 
restore corrupted or erased files.

System Recovery CD(s)
Sony Electronics
This program allows you to restore the software titles that shipped with your computer if 
they become corrupted or are erased. It can be used only to restore the hard disk of the 
Sony computer you purchased.

Using the System Recovery CD(s)

You can reinstall software titles that shipped with your computer if they are 
corrupted or erased. You may not need to recover the entire contents of your hard 
drive. If you experience a problem with your computer, reinstalling an individual 
device driver or software title may correct the problem. Use the Application 
Recovery CDs to reinstall individual applications or device drivers. See “ Using 
the Application Recovery CD(s)”  on page 99. 

The System Recovery CD contains a backup copy of all the software originally 
installed on your hard disk drive. It can be used only to recover the hard disk 
of the notebook computer you purchased.
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The System Recovery utility gives you two options:

❑ Full Restore without Format — Restores all the software titles that 
originally came with your computer without formatting the hard disk.

❑ Full Restore with Format — Formats the hard disk drive and then restores 
all the original software.

%�����������,�������!����,�� 9�:

1 Insert the Sony System Recovery CD in the CD-ROM drive.

2 Shut down your computer as described in “ Shutting Down Your Computer”  
on page 32.

3 Wait four seconds and then turn on your computer.
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Using the System and Application Recovery CDs
4 Click OK to signify you have read and accept the Microsoft End-User 
License Agreement.

5 When the System Recovery menu appears, follow the on-screen instructions 
to complete the recovery process.

&	�,����!����������������������	����������!����,�� 

1 Press and hold the power switch for more than four seconds to turn off the 
computer.

2 Turn on the computer and press the F2 key when the Sony logo appears. 
The BIOS setup menu screen appears.

3 Press the arrow keys to select the Exit menu.

4 Press the arrow keys to select Get Default Values and then press the Enter 
key. The message “Load default configuration now?” appears.

5 Check that Yes is selected, then press the Enter key. 

6 Press the arrow keys to select Exit (Save Changes) and then press the Enter 
key. The message “Save configuration changes and exit now?” appears.

7 Check that Yes is selected, then press the Enter key. The computer restarts 
from the Recovery CD.

Using the Application Recovery CD(s)

The Application Recovery CDs allow you to reinstall individual applications and 
device drivers if they are corrupted or erased. Reinstalling an individual device 
driver or software title may correct a problem you are experiencing with your 
computer, and you may not need to recover the entire contents of your hard drive. 
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If you do need to reinstall all the software titles that shipped with your computer, 
use the System Recovery CD. See “Using the System and Application Recovery 
CDs” on page 97.

%����������5��
�!�������!����,�� 9�:

1 Turn on your computer. If your computer is already on, close all 
applications.

2 When the Windows desktop appears, insert the first Sony Application 
Recovery CD in the CD-ROM drive. The Application Recovery utility loads 
automatically.

3 When the Application Recovery menu appears, follow the on-screen 
instructions to complete the recovery process.

Recovering Microsoft® Word 2000

If you recover your operating system using the System Recovery CD, Microsoft 
Word 2000 will not be recovered. Use the supplied Word 2000 CD-ROM to 
recover this application. The basic version of Word 2000 is preloaded, you may 
load other Word options from the Word Application CD.
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Troubleshooting
This section describes how to solve common problems you may encounter when 
using your notebook. Many problems have simple solutions, so try these 
suggestions before you contact Sony PC Support 
(http://www.sony.com/pcsupport).

Troubleshooting your notebook

When starting your notebook for the first time, the VAIO InitManager dialog box 
will appear. Please select “OK” to begin initial setup. If you do not execute the 
initial setup, you cannot use part of VAIO original hardware functions such as 
Jog Dial, Power Management tool, scroll function of pointing device, and 
keyboard shortcut key function combined with the Fn key.

#,����������������������

❑ Check that the notebook is plugged into a power source and that it is turned 
on. Check that the power indicator on the front panel of the notebook 
indicates that the power is on.

❑ Check that the battery pack is inserted properly and is charged.

❑ Make sure there is no diskette in the floppy disk drive.

❑ Confirm that the power cord and all cables are connected firmly, as described 
in “Connecting Peripheral Devices” on page 61.

❑ If you plugged the notebook into a power strip or UPS, make sure the power 
strip or UPS is turned on and working.

❑ If you are using an external display, check that it is plugged into a power 
source and turned on. Check that the brightness and contrast controls are 
adjusted correctly. See the manual that came with your display for details.

❑ Moisture condensation may have occurred. Do not use the notebook for at 
least one hour and then turn on the notebook.

❑ Take the battery pack off the notebook, unplug the power cord and plug it in 
again, then turn on the power.
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#,���������������D������,��,���������F��������������
,

❑ When the internal backup battery is low on power, it may not start your 
system properly. The message “Press <F1> to resume, <F2> to setup” 
appears at the bottom of the screen. Follow these steps:

1 Press F2. The BIOS Setup menu appears.

2 Set the date (month/day/year). Press Enter.

3 Press  to select System Time, then set the time (hour: minute: 
second). Press Enter.

4 Press  to select Exit, then press  to select Get Default Values. 
The message “Load default configuration now?” appears.

5 Select Yes and press Enter.

6 Select Exit (Save Changes), and then press Enter. The message “Save 
Configuration changes and exit now?” appears.

7 Select Yes, and then press Enter. The notebook restarts.

#,���������������D�����������������G"���������,��������	���H���������
���B�������������������

❑ Make sure there is no diskette in the floppy disk drive (non-bootable). 

❑ If a non-bootable diskette is in the drive, follow these steps:

1 Turn off the notebook, and then remove the diskette.

2 Restart the notebook and confirm that Windows starts properly. 

❑ If Windows still does not start, follow the steps below to initialize the BIOS:

1 Remove any diskette from the floppy disk drive.

2 Remove any peripheral devices connected to the notebook.

3 Turn off the notebook and then turn it on.

4 Press the F2 key when the Sony logo appears. The BIOS setup menu 
screen appears.

5 Press the directional arrow keys to select the Exit menu.

6 Press the arrow keys to select “Get Default Values” and then press Enter. 
The message “Load default configuration now?” appears. 

�

� �
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Troubleshooting
7 Select Yes, then press Enter.

8 Use the directional arrow keys to select “ Exit”  (Save Changes), and then 
press Enter. The message “ Save configuration changes and exit now?”  
appears.

9 Select Yes, then press Enter. The notebook restarts.

If your notebook continues to display the message “ Operating system not found,”  
and Windows does not start, contact Sony Customer Support.

#,�������������������������������������������

It is best to shut down your notebook using the Shut Down command on the 
Windows Start menu. Using other methods, including those listed here, may 
result in loss of unsaved data. 

❑ Try restarting the notebook. On the Windows taskbar, click the Start button, 
click Shut Down, and then click Restart.

❑ If you cannot restart as described in the preceding step, you can restart the 
notebook by pressing Ctrl+Alt+Delete.

❑ If the previous step does not work, press and hold the power button for at 
least four seconds. This turns off the power.

❑ If your notebook stops responding while playing a CD or DVD, stop the 
CD/DVD, and restart the notebook by pressing Ctrl+Alt+Delete.

❑ Unplug the notebook from the AC adapter and remove the battery pack from 
your notebook.

#,�������������������������������������������&���
�!���7

❑ Click Start, point to Program, point to Accessories, point to System Tools, 
and then click System Information. 

The Help and Support window appears.

❑ Click System Configuration Utility under the Tools menu.

✍ �	����$��
	�N��
N(���
���	�
�	��$�����
�����
������3
��
�����3�	��3
�������	����
�
����
��������������
��
��	����		��
��������
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❑ Click the Advanced button on the General tab, and Confirm the following 
information:

1 The message “ Standby function is enabled”  is displayed. If the message 
reads “ Standby function is disabled,”  click the Enable button.

2 The message “ Hibernation feature is enabled”  is displayed. If the 
message reads “ Hibernation feature is disabled,”  click the Enable 
button.

3 Click OK and restart your notebook.

%���.�����#�����������������������������

Your notebook’s operating system may become unstable if a lower power state, 
such as system hibernation is initiated and then changed before the notebook 
completely enters the lower power state. To restore the notebook to its normal 
operating stability: 

❑ Close all open applications.

❑ Push and hold the power button for four seconds or longer to shut down 
the notebook.

%���������	��,��������F��	���������
���

Use the PowerPanel utility to change the Thermal Control Strategy setting to 
Quiet. This setting slows down the CPU speed. See PowerPanel Help for more 
information.
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Troubleshooting the LCD screen

#,��� ��!��������
��

❑ Check that the notebook is plugged into a power source and that it is 
turned on. 

❑ Check that the power indicator on the notebook is on.

❑ Check that the battery pack is inserted properly and that they are charged.

❑ The notebook may be in LCD (Video) Standby mode. Press any key to 
activate the screen.

❑ The display mode may be set to external display mode. Press and hold the 
Fn key while pressing F7 several times.

#,��� ��!����!�����������������������������!���7

Press the Windows key and D key twice to refresh the screen.

%������������,�!��!����������
�����
�,�������!������������I���������
,

Use the controls on your external display to adjust the image. See the manual that 
came with your display for more information.

&��������!�������������������
������	��,�����
�,

You can use independent controls to change the video resolution of your display.

❑ Click Start, point to Settings, point to Control Panel, and then click the 
Display icon.

The Display Properties dialog box appears.

❑ Click on the Settings tab.

❑ Move the Screen Area slider to change your video resolution.

Troubleshooting the mouse and pointing device

#,�������������������

❑ If you are using an external mouse, check that the mouse is plugged into the 
mouse connector. See “Connecting a USB Mouse” on page 65 for details.

❑ If you connected an external mouse while your notebook is on, you must 
restart your notebook.
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❑ If you are using an optional Sony USB mouse PCGA-UMS1 series, check 
that the mouse is plugged into the USB connector.

#,������������!���������������������
,

❑ You may have disabled the pointing device without a mouse being connected 
to the notebook. You must restart the notebook to make the pointing device 
work again.

❑ If your pointing device is interpreting a single tap as a double-click, you 
must adjust the button assignments. Follow these steps:

1 Click Start, point to Control Panel, and then click on the Mouse icon.

2 Change the button assignments in the Mouse Properties dialog box. 
(One of the buttons is assigned to the double-click action.) 

%�����������������������9���
����������������������!����������:

❑ Click the Start button on the Windows taskbar, and select Shut Down to 
display the Shut Down Windows dialog box, then press Enter.

❑ If you cannot turn off your notebook as described in the step above, press 
Ctrl+Alt+Delete to restart the notebook.

❑ If you cannot restart your notebook as described in the step above, press and 
hold the power button for more than four seconds to turn off the notebook.

❑ If the pointer does not move while playing a disc, press Ctrl+Alt+Delete to 
stop playback and restart the notebook.

Troubleshooting drives, PC cards and peripheral devices

#,�	
���,�������������!������F��������������������������!��!���

❑ Click Start, point to Settings, point to Control panel, and then click System

The System Properties dialog box appears.

❑ Click the Device Manager tab.

❑ Double-click Floppy Disk Controller and then click Standard Floppy Disk 
Controller.

❑ Click Delete. The Confirmation window will appear.

❑ Verify that Delete From All Settings is selected and press OK.

❑ Click Update in the System Properties window.
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❑ Double click Disk Drive and confirm that GENERIC NEC FLOPPY DISK 
is shown.

#,�� ���� ; ��������������
�,����,�� ���� ; �������
,

❑ Make sure the optical drive is inserted correctly into the PC card slot.

❑ Make sure the label of the disc is facing up.

❑ If the disc requires software, make sure the software is installed according to 
the manufacturer’s instructions.

❑ A dirty or damaged disc may cause the notebook to stop responding while it 
tries to read the disc. If necessary, restart the notebook, remove the disc, and 
then check it for dirt or damage.

❑ If you see video but can not hear audio, check all of the following:

❑ Check that your DVD-ROM drive does not have the mute setting 
enabled.

❑ Check the volume setting in the audio mixer. 

❑ If you are using external speakers, check the volume settings, and then 
check the connections between your external speakers and the notebook. 

❑ Click Start > Control Panel > System > Device Manager. Check that the 
correct drivers are installed properly.

❑ Do not use adhesive labels to identify the CD. The label may come off while 
the disc is in use in the optical drive and cause the drive to malfunction.

❑ If a region code warning appears when you try to use your DVD-ROM drive, 
it may be that the DVD you are trying to play is incompatible with the 
DVD-ROM drive. Check the region code listing on the DVD packaging.

❑ Moisture condensation may have occurred. Leave the notebook idle for at 
least 1 hour with the notebook turned on.

#,�� ���� ; ����������,������������

❑ Make sure the notebook is turned on.

❑ Press the Eject button on the optical drive.

❑ If the Eject button does not work, you can open the tray by inserting a sharp, 
pointed object into the hole to the right of the Eject button.
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&�!��������������
�������9 ;:�����!��7�%�����������G ;��A����������������
������!��!��������������		H��������7

❑ Check that the DV device is turned on and that the cables are properly 
connected.

❑ Disconnect the i.LINK cable and connect it again.

#,�.��!����������������

❑ Make sure the PC card is compatible with Microsoft® Windows®.

❑ Use the Sony Notebook Setup utility to disable devices you are not currently 
using.

Troubleshooting software

#,���	��������������������������������!������

Contact the software publisher or designated provider for technical support. See 
the “About Software” section of this manual.

B���&�!
�!�������
�!������!�D�������������G����������������������
�!�����
� �����,����� ?�"#�9 ; ?�"#:������H������������������	��������������
�����

❑ Some titles require specific files that are located on the application CD. 
Insert the disc and try starting the program again.

❑ Make sure you place the CD in the tray with the label side facing up.

&��������!�������G����H����
�������B������#�����.
�,�������
�,��,�
����! � �

Sony suggests using the preinstalled Media Bar software to play audio CDs.

&�!������������� ;�������	�����

If your notebook is using the Ultimate Battery Life profile for its power saving 
mode, you cannot use DVgate or Smart Connect software. Please select another 
profile.
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#,����!�?��
�������	�������������������������
,

Disable echo function of the microphone by taking the following steps:

1 Click Start, point to Settings, and then point to Control Panel.

2 Click Yamaha DS-XG.

3 Click the Echo tab and remove the checkmark. Click OK.

❑ Contact the software publisher or designated provider for technical support

Troubleshooting the modem

#,�������������������

❑ Check that the phone line is plugged into the line jack. See “Connecting a 
Phone Line” on page 62 for details.

❑ Check that the phone line is working. You can check the line by plugging in 
an ordinary phone and listening for a dial tone.

❑ Check that the phone number the program is dialing is correct.

❑ Check that the software you are using is compatible with the notebook’s 
modem. (All preinstalled Sony programs are compatible.)

#,�������!��!��������
��

Your notebook is equipped with a V.90/K56flex compatible modem. Many 
factors may influence modem connection speed, including telephone line noise 
or compatibility with telephone equipment (such as fax machines or other 
modems). If you think your modem is not connecting properly to other PC-based 
modems, fax machines, or your Internet Service Provider, check the following: 

❑ Have your phone company check that your phone line is free from any line 
noise.

❑ If your problem is fax-related, check that there are no problems with the fax 
machine you are calling and that it is compatible with fax modems.

❑ If you are having a problem connecting with your Internet Service Provider, 
check that the ISP is not experiencing technical problems.

❑ If you have a second phone line available, try connecting the modem to that 
line.
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Troubleshooting audio

#,���������������������

❑ If the built-in speakers are turned off, press Fn+F3 to turn on the speakers. 
You can also turn on the speakers using the Jog Dial control.

❑ If the speaker volume is turned to the minimum, press Fn+F4, and then press 
 or  to increase the volume or you can use the Jog Dial control to control 

the volume. 

❑ If nothing is displayed when you press Fn+F3 or Fn+F4.

1 Double click System in Control Panel.

2 Set the sound device to enable in Device Manager.

❑ If your notebook is powered by batteries, check that the battery packs are 
inserted properly and that they are charged.

❑ If you are using an application that has its own volume control, check that 
the volume is turned up.

❑ Check the volume controls in Windows®.

❑ If you connect external speakers, check that the speakers are properly 
connected and the volume is turned up. If the speakers have a mute button, 
make sure it is off. If the speakers are powered by batteries, check that the 
batteries are inserted properly and that they are charged.

❑ If you have connected an audio cable to the Headphone connector, 
disconnect the cable.

#,���!�������������������

If you are using an external microphone, check that the microphone is plugged 
into the Microphone connector. See “Connecting an External Microphone” on 
page 75 for details.

Troubleshooting Memory Stick

&�����	�
������������������������&���������#����,����!�����������
��

❑ By the default setting from the factory, Visual Flow software starts 
automatically when you insert a Memory Stick into the slot.

� ➜
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❑ If VisualFlow is active and the image files in Memory Stick are not 
displayed, the format type of the Memory Stick can be different.

❑ Copy the data from the Memory Stick onto the hard drive and format the 
Memory Stick using Memory Stick Formatter software preinstalled on this 
notebook.

#����,����!��������������7�&�!�����!!����������������

❑ If you cannot find the icon for “Removable Disk (S:)” in “My Computer” on 
the Desktop, take the following steps.

1 Double-click the System icon in the Control Panel and Device Manager 
appears. If you cannot find the icon, click “Display all the options of 
Control Panel.”

2 Click Refresh.
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Resources
Sony provides several support options for your Sony computer. When you have 
questions about your computer and the preinstalled software, check these sources 
for answers, in the following sequence:

$ ;5&"8��$�.�!����6���J���������������<����

The User Guide (this manual) contains information on how to get the most 
from your computer, find help, and solve common problems. It also contains 
product specifications.

( �������I��������;5&"E��$�.�!����6���J���������
The electronic document contains additional information on customizing your 
computer. You can access this guide from the Windows Start menu by 
selecting Programs and then VAIO User Manual.

) #���
������
�����
��	�
����������,��!!����,�,�����������

���

��	�����

Most of the manuals for preinstalled software are located on your hard disk 
drive as online help files. You can access the online help files from the Help 
menu in the specific application. A printed manual is available for some 
applications.

* ;5&"���������5���

VAIO Support Agent can be accessed from the Windows desktop. Using 
advanced diagnostic technology, Sony’s VAIO Support Agent runs scheduled 
protections of your applications, network settings, and other important 
software settings. When your software is protected, you can use VAIO Support 
Agent to repair software problems by restoring your software to any of the 
previously protected states.

- ��,�.���������

Provides instant access to information on commonly encountered problems. 
Enter a description of your problem and the Knowledge Database searches for 
the corresponding solutions online. You can access the Sony PC Support at: 
http://www.sony.com/pcsupport
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This service provides you with answers to commonly asked questions. You can 
use this automated service to request a list of available topics and then select 
the topics that you want to receive. To contact the Sony fax-on-demand 
service, call 1-888-4SONYPC (1-888-476-6972). (Requires a fax machine or 
your fax software.)

0 ��

�����,�����������������

You can call and speak with a Sony Customer Support Representative without 
using your computer by calling 1-888-4SONYPC (1-888-476-6972). Software 
support is available free of charge for 90 days after the original date of 
purchase.
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Specifications

#���
 .�<?�$;�

.��!����� Crusoe™ Processor
TM5600 600 MHz*

����� ���� ���� 12 GB†

&��������������� 350,000 pixels (square pixels)

&����� ���!� 1/6 inch progressive scan
350,000 pixel CCD

��� f = 2.8 mm, F = 2.8

B�����6�
�!� Auto/Indoor/Outdoor/Hold

������������� Auto/ /Hold

;�������������

@�����1��I�

YUY2/RGB 24 bit 80 × 60, 160 × 120, 320 × 240, 640 × 480
Motion JPEG 320 × 240, 640 × 480

 ���
�,�@����� 30 frames/second maximum (overlay)

��������@����� 30 frames/second maximum (320 × 240 motion JPEG) 
15 frames/second maximum (640 × 480 motion JPEG)

���������5# 128 MB SDRAM (System uses 16 MB)

�� ��!��� 8.9" UWXGA (1024 × 480) TFT screen
with XWIDE™ active matrix

�(���!���#����, 512 KB (on die)

#.'< MPEG1 Digital Video supports full-screen playback

<�����!� 3D graphic accelerator with 8 MB video RAM

�����������
����� 16-bit CD-quality stereo sound

#���� V.90/K56flex compatible data/fax modem‡

'�������

������
�����

One PCMCIA type II card and card bus support

1
50
------
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6��
�?��������
����� Microphone
Stereo Speaker
MOTION EYE camera
Pointing device
Jog Dial control
MG Memory Stick

���!��
�6����� Jog Dial control and capture

%�
�!�����!������

������
�����

Fax send/receive

���!����

������
�����

Phone line (RJ-11)
USB port
Stereo headphone (MEGA BASS support)
Microphone jack (Mic-in/Line-in)
VGA monitor
i.LINK
DC in

����
����5!!��������Rechargeable battery
AC adapter /power cord
AV cable
Display adapter
Pointing device spare caps

�����!� 90-day limited express service**

Extendible to one year from original 
date of purchase upon registration

��������B�����, 90-day parts/labor standard**

Extendible to one year from original 
date of purchase upon registration

.�������A�������� 40 watts maximum (19.5 V DC/AC 100-240 V)

.�����#������� Energy Star Compliant
Advanced power management (APM) version 1.2

6�����, Lithium-ion

 ������� 9.76" (w) × 1.06" (h) × 6.02" (d)
(248 mm × 27 mm × 152 mm)

#���
 .�<?�$;�
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Specifications are subject to change without notice.
This product meets the standards of the International Energy Star Program for energy efficiency.

B����� 2.16 lbs. (980 kg)
(with supplied battery)

"��������

%����������

41ºF to 95ºF (+5ºC to 35ºC)
(Temperature gradient less than 18ºF/10ºC/hour)

"���������������, 20% to 80% (not condensed) when that humidity is less than 65% at 
95°F (35°C) (hygrometer reading of less than 84°F (29°C))

��������%���������� -4°F to 140°F (-20°C to 60°C) (temperature gradient less than 
18°F (10°C)/hour)

���������������, 10% to 90% (not condensed) when that humidity is less than 20% at 
140°F (60°C) (hygrometer reading of less than 95°F (35°C))

* MHz denotes microprocessor internal clock speed; other factors may affect application 
performance.

† GB means one billion bytes when referring to hard drive capacity. Accessible capacity may vary.
‡ Due to FCC limitations, speeds of 53 kbps are the maximum-permissible transmit power levels 

during download transmissions. Actual data speeds vary depending on the line conditions.
** Certain restrictions apply.

#���
 .�<?�$;�
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Index
A
AC adapter 25
AC power 25
adding

hardware 61
peripherals 61
printers 64

adjusting
brightness 36

air circulation 17
Alt key 34
Application Recovery CDs 99
Applications key 34

B
batteries 29

using 29
battery pack 26

charging 27
indicator light status 28
indicator lights 27
inserting 26
loading 26
power status 27
rechargeable 25
removing 29

brightness

adjusting 32, 36
built-in speaker 36

volume 36
buttons

Start 32

C
cameras

digital video camcorder 48
canceling commands 34
Caps Lock

indicator light 36
CD or DVD Media

cleaning 74
handling 74

CD-ROM discs
inserting 73

CD-ROM drive
closing lid 73
connecting 45, 71
using 71

charge status indicator light 27
charging battery pack 27
choosing

power source 26
cleaning

CD or DVD Media 74
Your Notebook 18
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coin-operated telephones 63
computer

condensation 19
lithium-ion battery 6
setting up 21
starting 31
troubleshooting 101, 108

connecting
CD-ROM drive 45, 71
coin-operated telephones 63
digital video recorder 48
external keyboard 65
external mouse 65
floppy disk drive 69
monitor 66
multiple phone lines 63
network 45
parallel devices 64
party phone lines 63
PBX 63
phone line 62
power source 25
printer 64
projector 67

connectors
DC In 25
external speakers 23
parallel 64
printer 64
USB 69

correction keys 33, 34
Ctrl key 34
cursor-movement keys 33

customer assistance
support options 112

D
DC In 25
digital video camera 48
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Index
F
faxes

laws governing 5
floppy disk drive

connecting 69
disconnecting 46, 70

Fn key 34
combination commands 36

function keys 34

G
Guide Mode 53

H
handling

CD or DVD Media 74
diskettes 71

Headphone connector 67
help 112

I
i.LINK 48
IEEE-1394 48
indicator lights

battery 27
Caps Lock 36
charge status 27
Num Lock 36
Scroll Lock 22, 36

input devices 4
Insert key 33, 34
inserting

battery pack 26
diskettes into drive 70

installing
hardware 61
memory 45
peripherals 61

interference 4, 17

J
Jog Dial 51

K
keyboard 33–35, 36

connecting 65

L
Launcher Mode 52
LCD 18

troubleshooting 105
lithium-ion battery

disposal 6
safety precautions 6

loading
battery pack 26

M
MagicGate 55
maintenance 17
memory module

installing 45
Memory Stick card slot 55
Memory Stick cards 55
Memory Stick media

displaying contents 56
microphone 21

troubleshooting 110
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modem
laws governing 5
troubleshooting 109

moisture condensation 19
monitor

connecting 66
switching among 37

mouse
connecting 65
troubleshooting 105

MovieShaker instructions 89
multiple phone lines 63

N
navigation keys 33
network

connecting 45
Num Lock

indicator light 36
numeric keypad area 33

O
online

help 112
operator keys 34
output devices 4

adding 64

P
parallel port 64
party phone lines 63
PBX 63
PC card

inserting 45

removing 46
slots 45
troubleshooting 108
Type II 45

phone
connecting line 62
jack 62
laws governing 5

power saving modes 59
System Hibernation 37, 60
System Suspend 36, 59
Video Standby 37

power sources 26
connecting 25

precautions 17
Print Screen key 34
printer

connecting 64
port 64

projector 67

R
radio interference 4, 17
rechargeable battery pack 25,
26
recharging battery pack 27
Recovery CDs 99
removing

battery pack 29
diskettes 70
floppy disk drive 46, 70

restoring data 99
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S
Scroll Lock 22

indicator light 36
selecting

power source 26
Shift key 34
Shut Down Windows 

dialog box 32
Sony Fax-on-Demand 

service 113
speakers

connectors 23
troubleshooting 110

Start button 32
starting

computer 31
startup problems 32
switching

display 37
monitor 37

System Hibernation mode 37,
60
System Recovery CD(s) 97
System Suspend mode 36, 59

T
technical support

support options 112
troubleshooting 101

startup 32, 101
turning on

computer 31
TV

interference 4, 17

U
USB connector 69
Using the Jog Dial Control 53

V
VAIO®  Action Setup 51
ventilation 17
video camera 48
Video Standby mode 37

W
Windows

taskbar 32
Windows Me

Explorer 34
Find window 34
help 34
key 34
key combinations 34
taskbar 103
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	Welcome
	Congratulations on your purchase of the Sony VAIO® Notebook. Sony has combined leading-edge techn...
	Features
	Exceptional performance
	Portability
	Sony audio and video quality
	Windows® Millennium Edition
	Communications

	Unpacking Your Notebook
	Remove the following hardware items from the box:
	Main Unit
	AV Cable
	Display adaptor
	Power cord
	AC adapter
	Rechargeable battery pack
	Spare pointing device covers



	Manuals
	VAIO® User Guide
	Microsoft® Windows® Millennium Edition Getting Started
	Software CD
	Microsoft® Word 2000

	Recovery CDs
	System Recovery CD(s)
	Application Recovery CD(s)

	Other
	Ergonomic Considerations
	Recommended position
	Position of your computer
	Furniture and posture
	Viewing angle of the computer’s display
	Lighting
	Placement of an external display

	Notes on Setup
	Setting Up Your Notebook
	Handling Your Notebook
	Cleaning Your Notebook
	Handling the LCD Screen
	On Moisture Condensation




	Setting Up Your VAIO C1 PictureBook™ Notebook
	This section describes how to start using your notebook and the internal and external devices, su...
	Locating the Controls and Connectors
	Front
	Left
	Right
	Bottom


	Connecting a Power Source
	Using the AC Adapter
	1 Plug the cable attached to the AC adapter into the DC In connector on the computer.
	2 Plug one end of the power cord into the AC adapter.
	3 Plug the other end of the power cord into an AC outlet.
	Connecting Computer to AC Outlet
	Notes on the AC Adapter


	Using Battery Power
	To insert the battery pack
	1 Make sure the Lock lever on the bottom of the computer is in the “unlock” position.
	2 Align the grooves and tabs on the battery with the notches and tabs on the back of the computer...
	3 Slide the Lock lever into the lock position.
	Inserting Battery Pack
	To charge the battery pack

	1 Connect the AC adapter to the computer.
	2 Insert the battery pack.
	Battery Indicator Light
	To remove the battery pack

	1 Turn off the computer.
	2 Slide the release levers to the UNLOCK position and slide the battery away from the computer.
	Unlocking Battery Pack


	Additional Notes On Batteries
	To insert the optional high-capacity battery pack (PCGA-BP54)
	Inserting High-Capacity Battery Pack


	Conserving Battery Power
	Starting Your VAIO C1 PictureBook Computer
	1 Lift the cover while holding the bottom of the computer firmly. Do not grasp the camera lens wh...
	Opening Your C1 PictureBook Computer
	2 Press the power button until the green power indicator light turns on.

	Turning on Your C1 PictureBook Computer
	3 If necessary, adjust the brightness controls for the LCD display. To decrease the brightness, p...



	Shutting Down Your Computer
	1 Click the Start button on the Windows® taskbar.
	2 Click Shut Down to display the Shut Down Windows dialog box.
	3 Select Shut down.
	4 Click OK.
	5 Wait for your computer to turn off automatically. The power indicator turns�off.
	6 Turn off any peripheral devices connected to your computer.
	If you are unable to shut down your computer:

	1 Close or end all operations.
	2 Shut down your computer by pressing Ctrl+Alt+Delete keys (at the same time).


	Using the Keyboard
	Keyboard
	Combinations and Functions with the Windows Key
	Indicators
	Combinations and Functions with the Fn Key


	Using the built-in MOTION EYE™ camera
	Capturing a still image
	1 Press the CAPTURE button to start Smart Capture.
	CAPTURE Button
	2 Select Still Viewer/Long Movie Player/Net Movie Player from the application list.
	3 Choose Still by clicking the on-screen Capture Mode button. To switch to Motion, click the on-s...
	4 The Finder window appears. Turn the MOTION EYE camera lens towards the subject you want to phot...

	Turning MOTION EYE
	5 Adjust the focusing ring.

	Adjusting the Focusing Ring
	6 Half-press the CAPTURE button on the computer. The image remains still for a few seconds. To di...

	Using the Self-timer

	1 Click Still Viewer/Movie Player from the switch applications list.
	2 Select Still mode.
	3 Click the Options button.
	4 Click Self-timer capture on the Capturing mode tab.
	5 Click OK.
	To create a panoramic image

	1 Capture the still images. Using the panoramic-assist function of Smart Capture, capture still i...
	2 Start the PictureGear software. For details, see the PictureGear section in this manual.
	To set the image quality and mode of MOTION EYE camera

	1 Click the Start button, point to Settings, and then click Control Panel.
	2 Double-click the MOTION EYE camera icon. The Camera Control Utility appears.
	3 Click the Image tab and drag the slider to the left or the right. The level settings increase a...
	4 Click Mode tab and click the item you want to set.
	5 Click OK.


	Using the Pointing Device
	Using the Pointing Device
	To replace the pointing device cover
	Replacing the Pointing Device Cover



	Using PC Cards
	To insert card
	1 Insert the PC card into the PC card slot with the front label facing up. Gently push the card i...
	Inserting PC Card
	2 Pull the release button, then push it down toward the slot.

	Release Button
	To remove a PC card

	1 Double-click in the task tray.
	2 The “Unplug or Eject Hardware” dialog displays.
	3 Select the hardware device you wish to remove by clicking it.
	4 Click Stop.
	5 Confirm the correct device is selected in “Stop a hardware device.”
	6 The message, “PC Card can now be safely removed from the system” appears. Click OK.
	7 Gently grasp the card and pull it out.
	8 Insert the PC card slot protector into the empty slot.


	Connecting with another VAIO® computer
	Connecting with an i.LINK cable

	Hard Drive Partition
	Connecting an i.LINK device
	To connect a digital camcorder
	Connecting Digital Camcorder

	DVgate™
	Digital Video Captures
	Adjusting Image Resolution




	VAIO Action Setup
	The Jog Dial™ Control
	Using the Jog Dial Control
	Using the Jog Dial™ Control
	Launcher Mode
	Using Launcher Mode
	1 Turn the Jog Dial control to select the item you want, then press the Jog Dial control. The win...
	JOG Guide Dialog Box
	2 Turn or press the Jog Dial control to use the desired function.
	3 To select another item, switch to the launcher mode and repeat from step 1.



	Guide Mode
	Using Guide Mode

	Using the Jog Dial Control with Sony Software
	Using the Jog Dial Control with Other Software
	Using a Dialog Box
	JOG Guide dialog box


	Internal Timer


	Using Memory Stick® Media
	Types of Memory Stick Media
	What is MagicGate?
	To Insert a Memory Stick Media
	1 Insert with the arrow facing toward the Memory Stick media slot and the label facing down.
	2 Carefully slide the Memory Stick in until it clicks in place.
	Inserting Memory Stick
	To view the contents of Memory Stick media
	If you cannot see the Removable Disk (S:) in the My Computer window on your desktop:

	1 Click Start, point to Settings and then Control Panel.
	2 Click System. The System Properties window appears.
	3 Select the Device Manager tab.
	To Remove a Memory Stick Media


	VisualFlow
	To use VisualFlow
	1 From the Start menu, point to Programs > VisualFlow > VisualFlow.
	2 Click on an icon in the View section on the main toolbar to select a display layout.
	3 Click on an icon in the Sort section on the main toolbar to select a sorting method.
	4 Resting your cursor on the left end of the main toolbar activates the current Memory Stick prop...
	5 Resting your cursor on the right end of the main toolbar activates a secondary toolbar with mor...
	6 Click an image to show a normal view centered on the screen.
	7 Movie files start playback when the view is enlarged. Click again on movie files to restore the...


	Notes on using Memory Stick media:
	Using Power Saving Modes
	Normal Mode
	System Suspend Mode
	To activate System Suspend Mode
	To return to normal Mode


	System Hibernation Mode
	To activate System Hibernation mode
	To return to Normal mode



	Connecting Peripheral Devices
	You can add functionality to your computer by connecting any of these optional peripherals:
	Connecting a Phone Line
	1 Open the phone line jack cover. The cover opens only to a 45-degree angle.
	Opening Phone Line Jack Cover
	2 Plug one end of the phone cable into the jack on the inside of the phone line jack cover. Make ...
	3 Plug the other end into the wall jack.



	Connecting a USB Printer
	To connect a printer
	Connecting a Printer

	To use a printer

	Connecting a USB Mouse
	To connect a USB mouse
	Connecting a USB Mouse


	Connecting an External Display
	To connect a computer display
	Connecting a Display

	To connect a projector
	1 Plug the display adapter into the computer's Out connector and the display’s RGB signal cable t...
	2 Plug the audio cable into the Headphone connector.
	Connecting a Projector
	To connect a TV

	1 Plug the supplied AV cable into the notebook’s AV Out connector.
	2 Plug the other ends of the AV cable into the�TV, as shown.
	Connecting a TV


	Using the Floppy Disk Drive (optional)
	To connect the floppy disk drive
	To insert a diskette
	Plugging in USB Cable

	1 Hold the diskette with the label side facing up.
	2 Gently push the diskette into the drive until it clicks into place.
	Inserting diskette
	To remove a diskette
	Removing diskette

	To remove the floppy disk drive when the computer is on

	1 Double-click the Remove Hardware icon in the task tray.
	2 The “Unplug or Eject Hardware” dialog displays.
	3 Select the hardware device you wish to remove by clicking it.
	4 Click stop.
	5 Confirm the correct device is selected in the “Stop a Hardware device” dialog�box.
	6 The message, “Floppy Disk Drive can now be safely removed from the system” appears. Click OK.
	7 Slide the unlock lever on the bottom of the computer in the direction of the arrow, and then un...
	1 Open the start menu, select Settings, Control Panel, and then the System icon. The System Prope...
	2 Click the Refresh button.
	3 In the “Stop a Hardware device” dialog box, confirm that the device can be safely removed from ...
	To carry the floppy disk drive
	Notes on handling diskettes

	Connecting an Optical Drive (optional)
	To Connect the CD Drive
	1 Remove the PC card slot protector from the PC card slot. See “Using PC Cards” on page�45 for de...
	2 Remove the PC card from the bottom side of the CD drive.
	Removing PC Card
	3 Insert the PC card into the PC card slot with the SONY logo facing up. See “Using PC Cards” on ...

	Inserting PC Card
	To Insert a Disc

	1 Press the Eject button. The disc tray slides out.
	CD-ROM Drive
	2 Place the disc in the tray with the label side facing up. Push the disc onto the hub until the ...

	Inserting Disc
	3 Close the tray by pushing it gently. The BUSY indicator on the drive flashes while your compute...

	Flashing BUSY Indicator

	Notes on CD and DVD Media
	To Remove the Drive
	Handling CD or DVD Media
	Cleaning CD or DVD Media


	Connecting External Speakers
	To connect external speakers

	Connecting an External Microphone
	To connect an external microphone


	Recording from a Microphone or Audio Equipment
	Switching the connector functionality
	1 Double-click on the task tray located in the lower right corner of the Desktop window. The Volu...
	2 From the Options menu, click Properties. The Properties window appears.
	3 In the Adjust Volume panel, select Recording, and then click OK. The�Recording Control window a...
	4 Select either Microphone or Line.
	Adjusting sound volume in the Recording Control window
	To increase the sound of the microphone:

	1 Double-click on the task tray located in the lower right corner of the Desktop window. If Micro...
	2 From the Microphone panel, click Advanced. The Advanced Controls for Microphones dialog box dis...
	3 Click Mic 20dB in Other Controls, and then click Close.
	Adjusting volume
	To make the microphone echo

	1 From the Start menu, select Settings, and click Control Panel. In the Control panel, double-cli...
	2 Select the Echo tab.
	3 Click Effective, you can also customize the setting by choosing options such as Time.
	4 Click OK.
	To effect the MIDI sound:

	1 From the Start menu, select Settings, and then select Control Panel.
	2 Click the YAMAHA DS-XG Audio Config icon. (If you do not see the icon that you are looking for,...
	3 Select the Synthesizer tab.
	4 Select the desired effect, and then click OK.

	1 From the Options menu, select Properties.
	2 In the Volume Adjust window, select Recording, and then click OK. The Recording Control window ...


	About the Software on Your Computer
	Adobe Acrobat Reader®
	Adobe Systems Inc.

	ArcSoft® PhotoPrinter™ 2000 Pro
	ArcSoft, Inc.

	DVgate™
	Sony Electronics Inc.

	McAfee® VirusScan®
	Network Associates, Inc.

	Media Bar™
	Sony Electronics Inc.

	Microsoft® Internet Explorer
	Microsoft Corporation

	Microsoft® Word 2000
	Microsoft Corporation

	MovieShaker™
	Sony Electronics Inc.

	Netscape Communicator®
	Netscape Communications

	OpenMG™ Jukebox
	Sony Electronics Inc.

	PictureGear™
	Sony Electronics Inc.

	Quicken® 2000 Basic
	Intuit, Inc.

	Smart Capture
	Sony Electronics Inc.

	VAIO Action Setup
	Sony Electronics Inc.

	VAIO Support Agent
	Sony Electronics Inc.

	VisualFlow™
	Sony Electronics, Inc.


	OpenMG™ Jukebox Software Instructions
	Registering OpenMG Jukebox
	Electronic Music Distribution (EMD) Services

	Starting OpenMG Jukebox
	OpenMG Jukebox Basic Controls


	Recording a CD
	1 Insert an audio CD into the optional CD/DVD-ROM drive.
	2 Click Recorder. The OpenMG CD Recorder displays.

	Transferring Songs to the MG Memory Stick®
	Transferring Songs (Check-out)
	1 Click the Portable Player icon on the OpenMG Jukebox main window. The�Portable Player window ap...
	Returning songs (Check-in)

	1 Start the OpenMG Jukebox software.
	2 Select the song you want to return in the Portable Player window, then click . To select more t...
	3 During check-in, the STOP button flashes. When check-in is finished, the song titles disappear ...


	To exit OpenMG Jukebox



	Software Information
	MovieShaker™
	Main window
	Importing Images and Sound Clips
	1 Click .
	2 Find the file you want to add.
	3 Select the file.
	4 Click Open. The file is added to the Clip tray.



	Create a Movie Using Shaker
	1 Click the Shaker tab.
	2 Select a mood by clicking a face in the Shaker tray.
	Shaker Tray
	3 Click . A thirty second scene is automatically generated and saved to the Product tray.
	4 To preview, switch the Work Panel to Product tray mode and press play.


	Editing Clips and Scenes
	Working Panel
	1 Double-click the clip or scene to move it to the Working Panel.
	2 Select the Effects tab from the Editing tray.
	3 Drag and drop the Effect you want to add from the Effects tray to the Effects palette on the Wo...
	4 See Help for instructions on adjusting effect duration and replaying clips/scenes.


	Saving a Movie
	1 Verify that the clip(s) you want to save is on the Product tray. See Help for more details on s...
	2 Click Export.
	3 Select the format in which you want the document to be saved.
	4 Click Next.
	5 Locate the folder to which you want the file saved.
	6 Name the file.
	7 Click Save.


	PictureGear™
	Managing Your Pictures
	1 Click the Folder tab and browse to locate your pictures.
	2 Select the pictures you want to have in a collection.
	3 From Collection menu, select Create New Collection.
	4 Enter a name for the collection and then click OK.




	Creating a Photo Album
	1 Select the pictures you want to use to make an album.
	2 From the Utilities menu, select Album Maker.
	3 Choose the type of Album you want and click OK.
	4 Now add more pictures, frames, text, and effects.
	5 When you are finished, select Create Album in File menu or click the Create Album icon on the t...
	6 Designate the folder where you want to save the Album.
	7 Enter the Target Album name, select Thumbnails and click OK.
	8 The new album can be viewed using most internet browsers.

	Using Panorama Maker
	1 Gather the source images into the same folder or collection.
	2 Select the images you want to use.
	3 From the Utilities menu select Panorama Maker.
	4 Select the correct lens and click OK. (If 35mm lens is selected, the prompt does not appear; to...
	5 Click the panoramic icon, near the bottom of the window.
	6 Click Full Stitch.


	Making Still Images and Panoramic from MPEG
	1 Select the MPEG file.
	2 From the Movie/Sound menu, select Scene break down.
	3 Then select Movie Stitch, to create a panoramic picture.


	For Answers to Your Software Questions
	Acrobat® Reader (Adobe Systems Incorporated)
	McAfee® VirusScan® (Network Associates, Inc.)
	Netscape Communicator® (Netscape Communications Corp.)
	PhotoPrinter™ 2000 Pro (ArcSoft, Inc.)
	Quicken® 2000 (Intuit Inc.)
	Windows® Millennium Edition Operating System, Internet Explorer, Word 2000 (Microsoft Corporation)
	Sony Service Center



	Using the System and Application Recovery CDs
	About Your Recovery CDs
	Application Recovery CD(s)
	Sony Electronics

	System Recovery CD(s)
	Sony Electronics


	Using the System Recovery CD(s)
	Full Restore without Format
	Full Restore with Format
	To use the System Recovery CD(s)
	1 Insert the Sony System Recovery CD in the CD-ROM drive.
	2 Shut down your computer as described in “Shutting Down Your Computer” on page�32.
	3 Wait four seconds and then turn on your computer.
	4 Click OK to signify you have read and accept the Microsoft End-User License Agreement.
	5 When the System Recovery menu appears, follow the on-screen instructions to complete the recove...
	If your computer does not start from the Recovery CD

	1 Press and hold the power switch for more than four seconds to turn off the computer.
	2 Turn on the computer and press the F2 key when the Sony logo appears. The�BIOS setup menu scree...
	3 Press the arrow keys to select the Exit menu.
	4 Press the arrow keys to select Get Default Values and then press the Enter key. The message “Lo...
	5 Check that Yes is selected, then press the Enter key.
	6 Press the arrow keys to select Exit (Save Changes) and then press the Enter key. The message “S...
	7 Check that Yes is selected, then press the Enter key. The computer restarts from the Recovery CD.


	Using the Application Recovery CD(s)
	To use the Application Recovery CD(s)
	1 Turn on your computer. If your computer is already on, close all applications.
	2 When the Windows desktop appears, insert the first Sony Application Recovery CD in the CD-ROM d...
	3 When the Application Recovery menu appears, follow the on-screen instructions to complete the r...


	Recovering Microsoft® Word 2000

	Troubleshooting
	This section describes how to solve common problems you may encounter when using your notebook. M...
	Troubleshooting your notebook
	My notebook does not start
	My notebook starts, but my system doesn’t start properly
	1 Press F2. The BIOS Setup menu appears.
	2 Set the date (month/day/year). Press Enter.
	3 Press to select System Time, then set the time (hour: minute: second). Press Enter.
	4 Press to select Exit, then press to select Get Default Values. The�message “Load default config...
	5 Select Yes and press Enter.
	6 Select Exit (Save Changes), and then press Enter. The message “Save Configuration changes and e...
	7 Select Yes, and then press Enter. The notebook restarts.

	My notebook starts, but the message “Operating system not found” appears and Windows does not start
	1 Turn off the notebook, and then remove the diskette.
	2 Restart the notebook and confirm that Windows starts properly.
	1 Remove any diskette from the floppy disk drive.
	2 Remove any peripheral devices connected to the notebook.
	3 Turn off the notebook and then turn it on.
	4 Press the F2 key when the Sony logo appears. The BIOS setup menu screen appears.
	5 Press the directional arrow keys to select the Exit menu.
	6 Press the arrow keys to select “Get Default Values” and then press Enter. The message “Load def...
	7 Select Yes, then press Enter.
	8 Use the directional arrow keys to select “Exit” (Save Changes), and then press Enter. The messa...
	9 Select Yes, then press Enter. The notebook restarts.

	My notebook stops responding or does not shut down
	My notebook does not enter the power saving mode I selected.
	1 The message “Standby function is enabled” is displayed. If the message reads “Standby function ...
	2 The message “Hibernation feature is enabled” is displayed. If the message reads “Hibernation fe...
	3 Click OK and restart your notebook.

	The Power Management setting is not responding
	The sound of my notebook’s fan is too loud


	Troubleshooting the LCD screen
	My LCD screen is blank
	My LCD screen continues to show the previous screen.
	The image on my connected external display is not centered or sized properly
	I want to change the video resolution of my display
	Troubleshooting the mouse and pointing device
	My mouse does not work
	My pointing device does not work properly
	1 Click Start, point to Control Panel, and then click on the Mouse icon.
	2 Change the button assignments in the Mouse Properties dialog box. (One of the buttons is assign...

	The pointer does not move (while using the pointing device or mouse)

	Troubleshooting drives, PC cards and peripheral devices
	My floppy disk drive icon doesn’t appear even though it is connected
	My CD or DVD drive is not playing my CD or DVD properly
	My CD or DVD drive tray does not open
	I cannot use digital video (DV) devices. The message “DV equipment seems to be disconnected or tu...
	My PC card is not working

	Troubleshooting software
	My software program stops responding or crashes
	When I click an application icon, the message “You must insert the application CD into your CD-RO...
	I hear background “noise” while using Windows Media Player to play my music�CDs
	I can not use the DVgate software
	My voice-related software does not work properly
	1 Click Start, point to Settings, and then point to Control Panel.
	2 Click Yamaha DS-XG.
	3 Click the Echo tab and remove the checkmark. Click OK.


	Troubleshooting the modem
	My modem does not work
	My modem connection is slow


	Troubleshooting audio
	My speakers have no sound
	1 Double click System in Control Panel.
	2 Set the sound device to enable in Device Manager.

	My microphone does not work
	Troubleshooting Memory Stick
	Image files do not open even though I insert a Memory Stick into the slot
	Memory Stick does not work. I cannot access the S: drive
	1 Double-click the System icon in the Control Panel and Device Manager appears. If you cannot fin...
	2 Click Refresh.



	Resources

	Specifications
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W


